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Preface


This document is a formal contract deliverable with an approval code 1. It requires Government

review and approval prior to acceptance and use. This document is under ECS contractor

configuration control. Once this document is approved, Contractor approved changes are handled

in accordance with Class I and Class II change control requirements described in the EOS

Configuration Management Plan, and changes to this document shall be made by document

change notice (DCN) or by complete revision.


Any questions should be addressed to:


Data Management Office

The ECS Project Office

Hughes Information Technology Systems

1616 McCormick Drive

Upper Marlboro, Maryland 20774-5372
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Abstract


This Science User’s Guide and Operations Procedures Handbook (Release B.0) provides 
description for using a number of X-based graphical tools that allow you to request, search for, 
retrieve, browse, and view data. It also includes a directory service, the Earth Science Online 
Directory (ESOD), with a World Wide Web interface that enables you to perform many of these 
functions as well as advertise data collections you may wish to provide. 

Keywords:  B0SOT, EOSView, ESOD, Desktop, DAR 
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1.  Introduction 

1.1 Identification 

This document responds to DID 205, providing a user’s guide for client software. 

1.2 Scope 

This guide described the tools delivered with Release B.0, Version 1. They are EOSView, the B0 
Search and Order Tool (B0SOT), the Earth Science Online Directory (ESOD), the Data 
Acquisition Request (DAR) Tool, and the Desktop. 

1.3 Purpose 

This guide is intended to provided description of the delivered tools at a level of detail suitable 
for science users. 

1.4 Status and Schedule 

The document will be available online by August 29, 1997. 

1.5 Organization 

The document is organized as follows: 

• Section 1 Introduction 

• Section 2 Related Documentation 

• Section 3 Getting Started: What is ECS? 

• Section 4 Finding and Retrieving Data Using the Release B.0 Client 

• Section 5 Command and Key Definitions/Descriptions 

• Section 6 Putting It All Together: Tutorial and Scenarios 

• Section 7 Frequently Asked Questions (FAQ) 

• Abbreviations and Acronyms 
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2.  Related Documentation 

2.1 Parent Documents 

The parent document is the document from which this Science User’s Guide and Operations 
Procedures Handbook (Release B.0) scope and content are derived. 

423-41-01 ECS Statement of Work 

2.2 Applicable Documents 

No documents were referenced within this Science User’s Guide and Operations Procedures 
Handbook (Release B.0) or that are directly applicable, or contain policies or other directive 
matters that are binding upon the content of this volume. 

2.3 Information Documents 

2.3.1 Information Documents Referenced 

The following document is referenced herein and, amplify or clarify the information presented in 
this document. The document is not binding on the content of the ECS Science User’s Guide and 
Operations Procedures Handbook (Release B.0). 

IMS Version 0 Search and Order Tool User’s Guide at 

http://www-v0ims.gsfc.nasa.gov/v0ims/users_guide_6/Cover-TOC.html 

2.3.2 Information Documents Not Referenced 

No known information documents not referenced herein and/or not directly applicable, amplify 
or clarify the information presented in this document. 
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3.  Getting Started


Mission to Planet Earth is a long-term, multi- and inter-disciplinary NASA research mission to 
study the processes leading to global climate change, and to develop a predictive capability for 
the Earth system on time scales of decades to centuries. 

The Earth Observing System (EOS) is the centerpiece of NASA's Mission to Planet Earth. EOS 
collects Earth science data, with emphasis on long-term, sustained data sets from carefully 
calibrated instruments on satellites in low Earth orbit. 

The EOS Data and Information System (EOSDIS) is an open, distributed information system that 
manages the data and information from a variety of pre-EOS and EOS-era Earth observation 
satellites, data from related Earth science field measurement programs, and other data essential 
for the interpretation of these measurements. EOSDIS provides end-to-end services from EOS 
instrument data collection, to science data processing, to full access to EOS and other Earth 
science data holdings. 

The EOSDIS Core System (ECS) provides a broad range of desktop services to allow users to 
find and use data and associated services distributed from science data centers, the Distributed 
Active Archive Centers (DAACs), as well as other external contributors. External contributors 
include international partners and cooperating data centers. ECS will control the EOS spacecraft 
and instruments, process data from the EOS instruments, and manage and distribute EOS data 
products and other selected data sets. ECS promotes exchange of data and research results within 
the science community, across multiple agencies, and internationally. 

3.1 EOSDIS Tool System Requirements and Limitations 

The ECS Desktop and many ECS tools are X-based graphical interfaces. Therefore, they must 
run in X-environments. The ECS Desktop is available for the following UNIX platforms and 
system configurations: 

The EOSDIS Release B.0 Desktop requires the following: 

Sun OS 5.5.1 - 32 Mbytes of RAM 
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Information on the system requirements and configuration of individual tools included with the 
Desktop are listed below: 

Desktop: 

• 24M RAM for DAAC User Version 

• 5M RAM for the Science User Version 

works on: 

• Sun - OS 5.5.1 

• windowing system: Motif 1.2.3 

EOSView: 

10M RAM 

works on: 

• Sun - Solaris 2.3/2.4/2.5 

• IBM - AIX 3.2.5 

• HP - HPUX 9.05 

• SGI - IRIX 5.3 

• DEC - OSF/1 v3.2 

• windowing manager: Motif 1.2 
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B0SOT: 

15M RAM 

works on: 

• machines running X windows system 

• 1024 x 768 resolution screen 

DAR Tool: 

24M RAM 

works on: 

• the DAAC User version of the Desktop 

Note: Macintosh and other PC platforms do not support EOSDIS X/Motif tools. 

3.2 Help Desk Services 

For assistance using the Release B.0 Client, please contact any of the Distributed Active Archive 
Center (DAAC) User Services Offices. 

Alaska Synthetic Aperture Radar (SAR) Facility - (ASF) DAAC 

Discipline: polar processes imagery, sea ice, SAR products


ASF DAAC User Services


Alaska SAR Facility


University of Alaska


PO Box 757320


Fairbanks, AK 99775-7320


907-474-6166 voice


907-474-5195 fax


Internet: asf@eos.nasa.gov


WWW: http://www.asf.alaska.edu
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EROS Data Center - (EDC) DAAC 

Discipline: land processes imagery 

EDC DAAC User Services 

US Geological Survey 

EROS Data Center 

Sioux Falls, SD 57198 

605-594-6116 voice 

605-594-6589 fax 

Internet: edc@eos.nasa.gov 

WWW: http://sun1.cr.usgs.gov/landdaac/landdaac.html 

Goddard Space Flight Center - (GSFC) DAAC 

Discipline: upper atmosphere, global biosphere, atmospheric dynamics, geophysics 

Goddard DAAC User Services 

NASA Goddard Space Flight Center 

Code 902.2 

Greenbelt, MD 20771 

301-286-3209 voice 

301-286-0268 fax 

Internet: gsfc@eos.nasa.gov 

WWW: http://daac.gsfc.nasa.gov/DAAC_DOCS/gdaac_home.html 
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Jet Propulsion Laboratory - (JPL) DAAC 

Discipline: physical oceanography, ocean circulation, air-sea interaction 

JPL DAAC User Services 

Jet Propulsion Laboratory 

Mail Stop 300-320 

4800 Oak Grove Drive 

Pasadena, CA 91109 

818-354-9890 voice 

818-393-2718 fax 

Internet: jpl@eos.nasa.gov 

WWW: http://podaac-www.jpl.nasa.gov/ 

Langley Research Center - (LaRC) DAAC 

Discipline: radiation budget, tropospheric chemistry, clouds, aerosols 

Langley DAAC User Services 

NASA Langley Research Center 

Mail Stop 157B 

Hampton, VA 23681-0001 

804-864-8656 voice 

804-864-8807 fax 

Internet: larc@eos.nasa.gov 

WWW: http://eosweb.larc.nasa.gov/hpdocs.html 
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National Snow and Ice Data Center - (NSIDC) DAAC 

Discipline: snow and ice, cryosphere, climate 

NSIDC DAAC User Services 

National Snow and Ice Data Center 

CIRES, Campus Box 449 

University of Colorado 

Boulder, CO 80309-0449 

303-492-6199 voice 

303-492-2468 fax 

Internet: nsidc@eos.nasa.gov 

WWW: http://www.nsidc.colorado.edu/NASA/GUIDE/index.html 

Oak Ridge National Laboratory - (ORNL) DAAC 

Discipline: biogeochemical dynamics 

ORNL DAAC User Services Office 

Oak Ridge National Laboratory 

PO Box 2008, Mail Stop 6407 

Oak Ridge, TN 37831-6490 

615-241-3952 voice 

615-574-4665 fax 

Internet: ornl@eos.nasa.gov 

WWW: http://www-eosdis.ornl.gov/ 
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3.3 About This Document 

This manual was written specifically for the Release B.0 Client running on a UNIX machine in

an X-environment. Netscape Version 2 was used to access the Release B.0 Client Web-based

tools. Though every effort was made to adapt instructions for general use on multiple platforms

using multiple browsers, some instructions and/or screen captures may vary slightly from

platform to platform. Any suggestions for improving this manual should be sent to the author at

the following address:


Karen McDaniel

Hughes Information Technology Systems

1616 McCormick Drive

Upper Marlboro, MD 20774-5372

Phone: (301)925-0799

FAX: (301)925-0321

Internet: kmcdanie@eos.hitc.com


Questions that remain after reading this manual should be referred to the nearest DAAC User

Services Office.
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4.	 Finding and Retrieving Data 
Using the Release B.0 Client 

Release B.0 provides a number of tools allowing a broad community of users to access, retrieve, 
and browse Earth Science data conveniently and efficiently. A brief description of the major 
elements of the release follows: 

Desktop 

The Desktop is a framework for organizing tools and data. Tools are represented by icons to start 
the B.0 Search and Order Tool, (B0SOT) Earth Science Online Directory (ESOD), and the 
EOSView image display tool, as well as access the ECS Data Handling System (EDHS). The 
size and arrangement of icons on the Desktop can be configured to fit individual preferences by 
using the Desktop's User Preferences option. 

B0 Search and Order Tool (B0SOT) 

The B0SOT is the main search and order tool for the initial ECS release and provides a 
consistent view of data sets from ECS, Version 0 heritage centers and the Version 0 cooperating 
data centers. It allows users to search science data holdings, retrieve high-level and detailed 
descriptions of datasets, view geographical coverage and representative browse images, and 
place orders for data. 

V0 WWW Gateway 

The EOSDIS V0 Web Gateway system provides single Web interface provides search and order 
tools for accessing a wide variety of global Earth science data and information held at many 
different NASA, NOAA, and international data centers. It is the only way to access Tropical 
Rainfall Measuring Mission (TRMM) data as well as International Partner data. These free 
services allow easy access to both summary and detailed data product descriptions, as well as 
browse images and fully processed science data. For more information or to initiate a search, go 
to http://harp.gsfc.nasa.gov/~imswww/pub/imswelcome/. 

Earth Science Online Directory (ESOD) 

ESOD is a Web-based searchable index that enables users to submit and to search advertisements 
related to Earth Science services, providers, and data. Advertisements provide relevant contact, 
copyright, and cost information and also direct hyperlinks to advertised data, tools, and services. 

Data Acquisition Request (DAR) Tool 

The Data Acquisition Request (DAR) tool is for use by authorized users only. It provides an X­
based graphical user interface (GUI) for requesting future acquisition of data from the Advanced 
Spaceborne Thermal Emission and Reflection Radiometer (ASTER) instrument. 
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EOSView 

EOSView is a data visualization tool that displays Hierarchical Data Format (HDF) files. It can 
be used to view data that had been ordered from EOSDIS. In addition, it provides a secondary 
mechanism for previewing browse files before order (the primary mechanism is integrated 
browse which is part of the various search and order tools). 

4.1 Getting and Installing the Release B.0 Science UserSoftware 
Remotely 

4.2 Getting and Installing the Release B.0 Client Software Locally 

4.3 Using the Release B.0 Tools 

The sections that follow include detailed instructions and representative screen captures intended 
to guide you through the best use of the tools as well as provide reference material that you may 
need from time to time. 

• Logging Into the ECS Desktop 

• Using the ECS Desktop 

• B0 Search and Order Tool 

• Browsing Data Using EOSView 

• Earth Science Online Directory 

• Data Acquisition Request Tool 

4.4 Logging Into the ECS the Desktop 

What is the Desktop? 

The Desktop provides a convenient way to organize EOSDIS tools and data. It provides a secure 
environment and allows users to configure it to individual preferences by using the Desktop's 
User Preferences option. 

Local log in 

If you have access to a Unix machine and an account, log in with your Unix ID and password. If 
you have the ECS client software downloaded onto that machine, you will be able to bring up the 
ECS Desktop locally and use ECS services after entering your ECS User ID and password. 
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Remote log in 

You can run the ECS client software remotely if you do not have the tools downloaded locally. 
To log into your local Unix account and run ECS client software remotely, follow the same 
procedure stated above to log into a local Unix machine. First, identify which machine 
(remote_machine_name) has the tools installed and make sure you have a Unix account on that 
machine. 

Then, 

1. Connect to remote machine - telnet (remote_machine_name) 

2.	 You will be prompted for userId and password for that machine. After login, to allow the X 
client/server communication - setenv DISPLAY (local_machine_name or xterm_ip):0.0 

3.	 You can use the command set up by the system administrator to run ECS client software (i.e., 
desktop) Quick List of Features 

Use the following commands to achieve the resulting actions as indicated in the table below. For 
example, click on File (use the left mouse to click unless otherwise indicated) to bring up Create 
Directory; then type in the directory name in the window provided and click OK. 

Table 4-1. Quick List of Actions and Commands 
Action Command 

To create a directory File > Create Directory 

To go to your home directory File > Create Directory 

To go up just one directory File > Go Up 

To open applications Selected > Open 

To open an additional window Selected > Open New Window 

To close the display window of the last directory 
you visited; also to close a duplicate window 

File > Close Window 

To move or rename a highlighted application or 
directory 

Selected > Move To 

To make another copy of an application or directory Selected > Copy To 

To delete an application or directory Selected > Delete 

To restore only the last object you deleted Selected > Undelete 

To open a duplicate Desktop display window View > Duplicate Window 

To refresh your display Desktop View > Refresh 

To access the Web-based searchable technical 
document server 

Tools > ECS Data Handling System (EDHS) 

To exit the Desktop File > Exit 
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4.5 Using the ECS the Desktop 

Following is a detailed description of the functions 

Creating a Directory 

To create a directory on the Desktop, 

1. Click File > Create Directory menu bar item. 

2. A dialog box will appear asking you to name the directory. 

3.	 Type in the name of the directory (e.g., test) you wish to create and hit Return or use the 
mouse to click OK. 

Maneuvering Around the Desktop 

1. To go to your home directory, click File > Create Directory menu bar option or hit Ctrl + H. 

2. To go up just one directory, click File > Go Up menu bar option or hit Ctrl + U. 

3.	 To return to a directory that you have left or to move to a directory that is in your Desktop 
display, double click on the icon for the directory to which you want to go. Or, you can click 
once on the appropriate directory to highlight it and then choose one of the Selected > Open 
menu bar options. If you choose the Selected > Open New Window menu bar option and you 
want to close the Desktop display window of the last directory you visited, highlight the File 
> Close Window menu bar option. 

4.	 The Selected > Open menu bar option is for opening applications only. It will be grayed out 
if you try to open anything else--like a directory. To open an application (e.g., ESOD), either 
double click on its icon or click once on the icon and choose the Selected > Open menu bar 
option. 

5.	 Any menu bar options that are not valid choices will be grayed out. (e.g., If you don't have 
any Desktop items highlighted, all of the Selected pull down menu bar options will be grayed 
out.) 

Moving, Copying, and Deleting 

1.	 To move or rename an application or directory, click once on its icon (e.g., test) to highlight 
it and then choose the Selected > Move To menu bar option. A dialog box will appear asking 
you where you want to move the item. Click on the text entry part of the box to activate it 
and click the OK button when you have finished to move or rename an application or 
directory. Click the Cancel button instead of the OK button if you don't want the changes to 
take effect. If you just type in a name without specifying a directory (e.g., test1), the 
highlighted application or directory will be renamed in your current Desktop display. If you 
type in a directory specification followed by the name of the file (e.g., 
/home/username/test1), the test directory you created above will be moved to the specified 
directory and renamed test1. 
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2.	 To make another copy of an application or directory, choose the Selected > Copy To menu 
bar item. A dialog box will appear asking you to choose a destination folder and a name for 
the copied item. Click on the text entry boxes to type in the destination and name. Click the 
OK button for the changes to take effect or the Cancel button to return to the Desktop 
without making any changes. 

3.	 To delete an application or directory, click once on its icon to highlight it and then choose the 
Selected > Delete menu bar option. A dialog box will appear asking you to confirm the 
deletion. Click the OK button if everything looks correct or click the Cancel button if you 
decide not to delete the file. 

**To restore only the last object you deleted, highlight the Selected > Undelete menu bar item. If 
you have made several deletions, you can only restore the last object you deleted. 

Opening a Duplicate Window 

1. 	 If you'd like to open a duplicate Desktop display window, choose the View > Duplicate 
Window menu bar option. Any changes you make to this duplicate window will also be made 
to the original Desktop window. To close the duplicate window, click File > Close Window 
menu bar item. 

Setting Your User Preferences 

1.	 The icon display on the Desktop can be altered by selecting the View > User Preferences 
menu bar item. Icons can be displayed in any one of four sizes in either iconic format, which 
is the default display preference, or in hierarchical format. To choose an icon size, select 
either one of four sizes: tiny, small, medium (default), or large. Click the Apply button to see 
how your Desktop display changes. In the iconic format, all files and applications are 
displayed as icons with text labels underneath each icon on the Desktop. In the hierarchical 
format, files and applications are displayed alphabetically and left-justified with text labels to 
the right of each icon. To see how your Desktop display changes, click the Apply button. 

2.	 The User Preferences Desktop tool also allows you to specify how you would like to open 
your directories. Directories can be opened in place, which is the default display preference, 
or in a new window. Opening directories in place allows your current Desktop window to be 
superseded by the window displaying the contents of the newly opened directory. To return 
to your previous directory, find the icon of the directory on your desktop, and double click on 
it. Opening directories in a new window allows you to see the Desktop displays of multiple 
directories simultaneously. When you want to return to your previous directory, just close the 
current directory by selecting the File > Close Window menu bar option. If you do not 
specify a preference in the User Preferences tool for opening directories, you can always 
choose how a directory or application will be opened using the Selected menu bar option. 
This menu bar option provides the same choices for opening directories as does the user 
Preferences tool. 

3. 	 To save your Desktop display preferences, click the Save button and then click the OK 
button. To return to the default Desktop display options at any time, click on the User 
Preferences Defaults button and then click OK. 
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Refreshing Your Desktop 

1.	 Sometimes your Desktop display may need to be refreshed. To refresh your display, click 
Desktop View > Refresh menu bar item. The Desktop icons will disappear briefly and 
reappear aligned according the User Preferences you selected. 

Exiting the Desktop 

1. To exit the Desktop, click File > Exit menu bar item or hit Ctrl + Q. 

4.6 B.0 Search and Order Tool (B0SOT) 

4.6.1 Introduction 

This is a guide to new users of the B0 Search and Order Tool (B0SOT). It also functions as a 
reference manual for more experienced users. It contains the necessary information for accessing 
and running B0SOT, including 

• An introductory high level description of the system 

• The system overview 

•	 Access procedures for both the graphical user interface and the World Wide Web 
versions of the system 

• A list of commonly asked questions and their answers 

• Important points of contact for resolving difficulties 

You are then provided a more detailed description of the functionality of the system. and 
additional helpful information, including science scenarios, and command definitions. 

4.6.2 System Description 

4.6.2.1 General Overview of B0SOT 

The B0SOT is a cooperative effort among various archives around the country and the Goddard 
Space Flight Center (GSFC) Earth Science Data Information System (ESDIS) project. This 
system allows you to search for and order data from several data centers in a single session. 
B0SOT will facilitate Earth science research through improved access to existing data and serve 
as a prototyping testbed for the EOSDIS Core System (ECS). B0SOT is being used as the main 
search and order tool for the initial ECS release. The ECS is being built to accommodate the 
huge amounts of data expected from the EOS instruments to be launched beginning in 1998. 
B0SOT provides a consistent view of data sets held at ESDIS data centers, allowing users 
without specific prior knowledge of the data to search science data holdings, retrieve high-level 
descriptions of data sets and detailed descriptions of the data inventory, view browse images, and 
place orders for data. 
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User Interfaces 

The system is accessible over the Internet, with a graphical user interface. It supports data search 
and order, directory searches, guide information, and browse images. A World Wide Web 
(WWW) version has also been developed to provide easier access to the data holdings. 

Graphical User Interface 

The Graphical User Interface (GUI) is a graphical environment that operates under the 
X-Window system, allowing you to display multiple windows simultaneously, and it supports a 
mouse for easy user interaction. It also allows search areas to be specified from a global map and 
provides an interactive data browse facility and coverage map of data products. This interface 
requires Internet access to function properly. 

To run the GUI, the hardware display device must be able to run the X-Windows System and 
communicate over the Internet. The software targets a 1024 x 768 resolution screen. The 
minimum number of supported color planes is eight, and monochrome monitors are not 
supported. A standard X-terminal can be used, as well as any personal computer with a 
compatible X server or emulator. 

WWW Interface 

The World Wide Web (WWW) interface is a web-based version of the B0SOT. It is available at 
the following URL: http://eos.nasa.gov/imswelcome 

4.6.2.2 System Overview 

This section contains brief information to quickly get you started. It includes login instructions, a 
brief system descriptions, instructions for navigation through the system for both the GUI and 
WWW versions; a tutorial of the GUI version to lead the new user through the system; answers 
to commonly asked questions; as well as a contact to handle technical problems or questions. 

4.6.2.2.1 Graphical User Interface (GUI) 

Log-In Instructions


Users may access B0SOT by telnet to any one of the following Internet addresses:


• telnet eosims.asf.alaska .edu 12345 - connects to Alaska SAR Facility 

• telnet eosims.cr.usgs.gov 12345 - connects to EROS Data Center 

• telnet eosims.msfc.nasa.gov 12345 - connects to Global Hydrology Resource Center 

• telnet eosims.gsfc.nasa.gov 12345 - connects to Goddard Space Flight Center 

• telnet eosims.jpl.nasa.gov 12345 - connects to Jet Propulsion Laboratory 

• telnet eosims.larc.nasa.gov 12345 - connects to Langley Research Center 
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• telnet eosims.saa.noaa.gov 12345 - connects to NOAA-Satellite Active Archive 

• telnet eosims.colorado.edu 12345 - connects to National Snow & Ice Data Center 

• telnet eosims.esd.ornl.gov 12345 - connects to Oak Ridge National Laboratory 

Note: If you are connecting from a VMS machine the command format is: 

• telnet/port=12345 eosims.cr.usgs.gov 

where the machine name changes as appropriate. 

Follow the instructions on the screen once the connection is made. If the fonts are too large, too 
small or otherwise incorrect, contact the Data Center USO. 

When a new window opens in the GUI, there may be a frame on the screen. Without pressing the 
mouse buttons, move the mouse to position the frame to a desired location on the screen and 
click the left mouse button. The "Welcome" screen is the first screen to appear. If you need to 
reposition the screen, position the cursor on the screen title bar, press the mouse button down, 
move the screen to the desired location and release the mouse button. To continue, use the mouse 
to position the cursor, and click on the buttons at the bottom of the screen or select items from 
the menu bar. 

There is a User Profile button on the bottom of the Welcome screen. Enter at least your name, 
city, country, affiliation and telephone number (and e-mail address, if possible) in the User 
Profile information. User Profile is also available from the GoTo menu. 

When at the Search Screen, use the mouse to position the cursor and select a "Search Type" 
before proceeding with filling in the search criteria. Inventory is the default. 

4.6.2.2.2 Hardware Requirements for the GUI 

The hardware display device must be able to run the X Windows System. An Internet connection 
to B0SOT is necessary to run this system. The software was built to target a 1024 x 768 
resolution screen. On lower resolution screens, the image will appear too large, while on higher 
resolution screens, the image will appear too small. The minimum supported color planes is 
eight. Monochrome monitors are not supported. If you experience problems while running the 
client using MacX or X-Vision, contact the USO for assistance. If you experience problems 
while running the client using another X-Window emulator, try using the WWW version. 

4.6.2.2.3 GUI Screen Descriptions 

Screens comprise menu bars, fields, dialog boxes, buttons, and windows. Screen layouts of these 
components follow simple compositional conventions: fields for input and display are labeled, 
pop-up windows appear at the center of the screen, and buttons are identified at the bottom of the 
screen. The screen name appears at the top of each screen. 
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Each screen has three pull down menus (Go To, Screen Functions, and Help) available from the 
menu bar at the top of the screen. At the bottom of the screen are buttons for commands 
considered the most commonly used for the current screen. The GoTo and Help pull down 
menus will always show the same options. However, depending upon the current screen or 
current selections, some items may be inactive. 

Items that are inactive are grayed out, and the system will not allow the cursor to move to these 
areas. In other words, the system prevents an invalid selection. 

Go To menu option is for "going to" other parts of the system (e.g., search screen, Inventory, 
Directory, Browse, Detailed Information, Coverage Map, Order Data, Status, User Profile, 
Comments, Welcome, and Exit B0SOT). 

Screen Functions menu option is for selecting options applicable to the current screen or 
function. 

Help menu option provides access to help. There are nine types available: Select Item, Screen, 
Commands, Functions, System, Help, Glossary, Acronym List, and User Services Offices. When 
using Select Item, the cursor will change to a question mark. Simply place it on the field in 
question and click. The system will pop up a window containing help for that field. 

4.6.2.2.4 Navigating the GUI system 

Navigate between screens or out of the system by using menu bar options or buttons. To access 
or leave the menu bar, use the mouse to position the cursor on the menu bar options and make 
selections. When you use a multi-button mouse, the left mouse button is for selecting items on 
the screen. In the menu bar, use the mouse to move to the desired menu window (either "GoTo", 
"Screen Functions", or "Help"). Buttons (commands most commonly used) are identified at the 
bottom of each screen. 

To navigate between fields within a screen, use the mouse to position the cursor. 

Arrow keys can also be used; however, movement is more efficient using the mouse. Use the 
mouse to position the cursor to make selections within pop-up windows. In listed options (e.g., in 
a menu bar window or in a valids window), use the mouse to position the cursor, and click the 
left mouse button to select or deselect items. 

To enter information in a field, select the field with the mouse; then either type information 
manually or select from a list of valids (where available). To use a Valids list, click on the List 
button, to the right of the field, to pop-up its valids list. Use the mouse to position the cursor and 
click to select or deselect items. For multiple selections, see Entering Search Criteria. 

At the Inventory Results screen, once an Inventory search is performed, users may mark granules 
for other levels of information (Detailed Information, Browse, etc.) or to perform actions (e.g., 
Order). Users must "mark" granule(s) before attempting to "Go To" one of these other options. 
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4.6.2.3 WWW Interface 

The WWW interface provides many of the capabilities of the GUI in an easy to use interface. In 
addition, it allows you to download preselected popular data and images quickly. 

4.6.2.3.1 Access Instructions 

The WWW interface is available at the following URL: http://eos.nasa.gov/imswelcome. It is 
also available as a link from the EOSDIS IMS Homepage. 

4.6.2.3.2 Hardware/Software Requirements 

A web browser is necessary to use this interface. Users have found the most success using 
Netscape. The WWW interface includes a browser test form so that you may determine whether 
your browser has everything needed to run the WWW interface. 

4.6.2.3.3 WWW Screen Descriptions 

The screens contain option buttons, text and input areas, a keywords legend, as well as hyper 
links. The most common activities are available as buttons at the top of each page. This list of 
buttons is called the button bar. To use these buttons, simply position the mouse (or cursor) on 
the desired button, and click the left button on the mouse. Greyed-out buttons cannot be selected. 
At the bottom of every page, there is a set of abbreviations ([A], [BI], etc.). These abbreviations 
are occasionally used in the interface on small buttons. There is a Help button at the top of every 
page. It will take you right to the appropriate section in the User Manual. There might also be 
very small Help buttons right on the page; these will take users to information about items next 
to where the curs or is sitting. 

4.6.2.4 Most Commonly Asked Questions . . . and their answers 

1. What is the difference between a Directory, Inventory and Guide search? 

•	 A directory search is a collection of uniform descriptions that summarize the contents of 
a data set. It provides information suitable for making an initial determination of the 
existence and contents of each dataset. Each directory entry contains brief data set 
information (e.g., type of data, dataset name, and time and location bounds). Note: This is 
a good place for novice users to start. 

•	 An inventory search  is a set of descriptions of granules from one or more data sets with 
information required to select and obtain a subset of those granules. Granule descriptions 
typically include temporal and spatial coverage, status indicators, and physical storage 
information. An inventory may describe physical granules, logical granules, or both, 
including a mapping between them if they are not identical. 

•	 A guide search is a set of detailed descriptions for one or more datasets and related 
entities, containing information suitable for the location and content of each dataset and 
its potential usefulness for a specific application. 
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2. What is a granule? 

It is the smallest subset of data from a dataset that is independently archived. 

3.	 If an experimental search from the Users Guide calls for a repeating time range how is 
this done? 

On the search screen under the Date/Time section there are two options. One is 
Continuous Time Range and the other is Annually Repeating Time Period. Move the 
cursor to the selection button and click to select the desired range type. 

4.	 What is the difference between “Continuous Time Range” and “Annually Repeating 
Time” period? 

•	 A Continuous Time Range allows you to shorten the search criteria and narrow the 
search, for example, the last 10 years (1984 to 1994). 

•	 The Annually Repeating Time Period allows you to enter a specific seasonal range 
within a year, for example, the month of July for the last 10 years. This narrows the 
search and is beneficial when a certain crop grows well in a specific season within a year. 

5.	 How does the scientist with no knowledge of sensors and platforms know which platform 
and/or sensors to choose? 

The system contains a feature known as dependent Valids. Making selections in one 
dependent valids field limits the choices in other fields to those that are appropriate to 
choices already made. 

The scientist could also start with a Directory or Guide search. Only specify the criteria 
that is known. Another option would be to access a definition of the term in question 
from the Valids List for that field. From the Definition Screen window, you can access 
the Guide information by clicking on the Guide Info button. This will give specific 
information on sensors. 

6. What does the utility FTP Browse do? 

The FTP Browse feature allows the user without X capabilities to transfer a browse 
image file from a public access server onto the user’s system. The user can than view the 
image. 

7. What would cause the words on my screen to be cut off? 

The words on the screen will be cut off if the font settings need to be adjusted. You 
should contact your local administrator or imsv0@eos.nasa.gov. 

8. Why is my neighbor's screen light blue with mauve menu bars and mine is another color. 

The terminal color settings need adjusting. You should contact your local system 
administrator or imsv0@eos.nasa.gov. 
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9. What if the B0SOT interface window is bigger than my screen? 

A higher resolution screen is needed. You can, however, pan to various parts of the 
display screen or resize the display screen. 

10.	 What does it mean when I log on to the B0SOT interface and it says "Unable to initialize 
GDBM directory file. See support staff."? 

This means that you already has a session running. You can only login to the B0SOT 
interface one time. 

4.6.2.5 Points of Contact for Problems/Comments 

For assistance using the B0SOT, please contact any one of the Data Center User Services 
Offices. 

4.6.3 Detailed Description Of The System 

The following sections are detailed descriptions of the functionality available in this release of 
B0SOT. 

4.6.3.1 User Profile 

The User Profile function allows you to supply an address and other contact information as well 
as Billing and Shipping addresses. It may be accessed from any point in the system through the 
GoTo menu. To use this function, select the information type (User, Billing, or Shipping). Once 
you have entered one, if the others are the same, select Copy from... under the Screen Functions 
Menu bar window or from the buttons below the address field. Address information is required 
for the following functions: Comments, Order Data, and Browse. 

Near the bottom of the screen is the Restricted Access field. This allows you to make requests for 
data to which you have special rights. Contact User Support at the Data Center holding that 
restricted data. 

The restricted access key can be up to sixteen (16) characters; only alphanumeric characters are 
significant, and case is not significant. The User Support at the Data Center will need to know 
the chosen restricted access key as well as EXACTLY how your name is entered to arrange for 
the server to unlock your access to the restricted data. This information is stored along with other 
profile information and is normally marked only visible to you. 

In the near future, you will be able to designate a destination for their user comments. Currently, 
a default value is being used. The destination is displayed in the field labeled Email Destination 
for Comments in the lower right corner of the User Profile screen. 

User Profile Caveats 

You must fill in at least first and last names, city, country, phone, affiliation category and type. If 
possible, please include an Internet e-mail address. Last name, first name and Internet e-mail 
address are necessary for a Browse request. 
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4.6.3.2 Search Types 

From the Search screen, you may create criteria for three different types of searches. They are 
Guide, Directory and Inventory. There is also a special type of Inventory search called a Granule 
ID search. 

4.6.3.2.1 Guide 

The Guide provides detailed descriptions about data sets, platforms, sensors, projects, and data 
centers. Currently Guide may be accessed four ways: a Guide type search from the Search 
screen, Valid Keyword searching using the Guide Info button in a Valids List pop-up, from the 
results of a Inventory search, and from the results of a Directory search. 

4.6.3.2.1.1 Guide Type Search 

To perform a Guide search, click on the diamond to the left of the word Guide in the Search 
Type selection area near the top left of the screen. You can either perform a free text search, a 
search by valids or both. The geographic search, processing level, day/night, browse only 
granules, number of granules returned per data set, and time search options are deactivated. 
There is a Free Text search option that allows you to type in any phrase as search criterion. A 
Free Text search will search all the guide documents for the word(s) entered in the text field. For 
example, if your enter "DMSP", the system will return with a list of all guide documents with the 
word DMSP in them. If the words "DMSP SSM/I" are entered, the system will return a list of all 
guide documents that have either the word DMSP or SSM/I in them. 

4.6.3.2.1.2 Valid Keyword Searching 

Valids keyword searching is done from a Valids List for data set, platform, sensor, project or 
data center. If your are unfamiliar with a listed keyword, they may select (highlight) one item 
then click on the Definition button. The Definition window will appear and display the definition 
of the item selected (highlighted). To view associated Guide documents for the selected item, 
click on the Guide Info button. This option provides access to guide documents written about 
that keyword. 

4.6.3.2.1.3 From Inventory Results 

From the Inventory Results users may highlight a granule and select Guide from the GoTo menu, 
then Guide Information for Selected Granules from the Guide cascading menu. If your are in the 
Detailed Inventory screen, and, therefore, are looking at a specific granule already, you can 
select Guide from the GoTo menu, then Guide Information for Selected Granules from the Guide 
cascading menu. If a granule is not selected, the current granule will be used to do the Guide 
search. 
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4.6.3.2.1.4 From Directory Results 

From the Directory Results you may highlight a data set title and select Guide from the GoTo 
menu, then Guide Information for Current Data Set from the Guide cascading menu. If you are in 
the Directory Details screen, and, therefore, are looking at a specific data set already, you can 
select Guide from the GoTo menu, then Guide Information for Current Data Set from the Guide 
cascading menu. Either way, the system will ask if you want to see data set, platform, sensor, 
project or data center or all of above. Once you make a selection and click on the OK button, the 
system will perform a Guide search based on the criteria selected. 

4.6.3.2.2 Directory Search Type 

The Directory provides brief, concise high-level information (called DIFs) about data sets from 
any point in the system. This function accesses information from the Global Change Master 
Directory (GCMD) for B0SOT supported data only. If a you are interested in DIF information 
outside those data sets supported by B0SOT, then the GCMD must be accessed directly (a 
hyperlink to the GCMD information is available from the Welcome screen). This function has 
proven particularly useful for focusing and refining searches. Currently, Directory information 
may be accessed three ways: a Directory type search from the Search screen, from the results of 
an Inventory search, and from the results of a Guide search. 

4.6.3.2.2.1 Directory Type Search 

To perform a Directory search click on the diamond to the left of the word Directory in the 
Search Type selection area near the top left of the screen. Search criteria include 

• Source/Platform 

• Sensor 

• Geographic Information (rectangle, select from map, and global granules only) 

• Date/Time (continuous time range only) 

• Parameters 

• Data Center ID 

• Campaign/Project 

4.6.3.2.2.2 From Inventory Results 

From the Inventory Results users may highlight a granule and select Directory from the GoTo 
menu, then Data set Information for Selected Granules from the Directory cascading menu. If 
you are in the Detailed Inventory screen, and, therefore, are looking at a specific granule already, 
they can select Directory from the GoTo menu, then Data Set Information for Selected Granules 
from the Directory cascading menu. If a granule is not selected, the current granule will be used 
to do the Directory search. 

4-14 205-CD-004-001




4.6.3.2.2.3 From Guide Results 

From the Guide Results you may display a document and then select Directory from the GoTo 
menu, then Data Set Information for Current Guide Document from the Directory cascading 
menu. The system will create and launch a Directory search. 

4.6.3.2.2.4 Directory Caveats 

The Directory function accepts appropriate information from and passes information to other 
B0SOT functions so that you need not enter information a second time (unless specifically 
refining or revising search criteria). However, the Directory search capability only allows 
geographic searches by lat/lon range (rectangle), select from map and global granules only. 
Therefore, if you start with an inventory search where geographic information is specified in any 
form other than those just mentioned, then choose to perform a Directory search, the geographic 
information WILL NOT be passed to the Directory search. You must re-specify the geographic 
information. 

If in the Inventory search, you did specify one of those three types, the information will be 
passed to the Directory Search screen and need not be retyped. 

The Data set Detailed Information default display is the entire file. You may select certain pieces 
of information by clicking on the buttons above the text window (e.g., Attributes.....). You may 
also deselect an information choice to remove it from the display by clicking on the 
corresponding button again. 

Directory Operational Scenario is as follows: 

A Directory query is entered in B0SOT, which builds a Directory search message. If the query 
specifies a data center, the search message is transmitted only to that data center. 

The data center maps the query and sends back entry identifiers for any data sets that satisfy the 
query in a Directory Results message. B0SOT uses the entry ID to retrieve the appropriate DIF 
information from the GCMD. The GCMD information is displayed in the B0SOT system 
interface as data set-level information. 

4.6.3.2.3 Inventory Search Type 

The Inventory Search function provides descriptions of pieces of data (granules) that are 
available for request from a data archive. This function is for accessing Inventory Information 
which includes the attributes of the data that will help you to distinguish between granules of 
data so that decisions on which granules to request may be made. Currently Inventory 
information may be accessed two ways: an Inventory type search from the Search screen, and 
from the results of a Directory search. Future enhancements include the ability to perform an 
Inventory search from the results of a Guide search. 
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4.6.3.2.3.1 Inventory Type Search 

Users may perform an Inventory search from the Search screen by selecting the Inventory Search 
Type. The following search criteria include 

• Source/Platform 

• Sensor 

•	 Geographic Information (point, rectangle, four corners, select from map, point and range, 
or global granules only or global search) 

• Date/Time (continuous time range, or annually repeating time period) 

• Parameters 

• Data Center ID 

• Campaign/Project 

• Day/Night Flag 

• Granules with Browse Products 

•	 Data Processing Level, an option to specify a Granule Cap which will limit the amount of 
information returned from the archives 

A special type of Inventory search is available. Users need only supply the Granule ID and its 
corresponding Data Set name to execute the search. The geographic coordinates are implied from 
the granule itself. In some cases a Datatake ID or wildcarding can be used in place of the full 
Granule ID, but that is at the discretion of the individual data centers. 

4.6.3.2.3.2 From Directory Results 

From the Directory Results you may highlight a data set title and select Inventory from the GoTo 
menu, then Granule Information for Selected Data Set from the Inventory cascading menu. If 
you are in the Directory Details screen, and, therefore, are looking at a specific data set already, 
you can select Inventory from the GoTo menu, then Granule Information for Selected Data Set 
from the Inventory cascading menu. If a granule is not selected, the current granule will be used 
to do the guide search. 

4.6.3.2.3.3 Special Situations: "The Wall" 

The EROS Data Center (EDC) has implemented a "wall" beyond which a search cannot run. 
This is because of the enormous number of granules for their data sets. If there weren't a wall, 
some searches may take a considerable amount of time to run and hundreds of thousands of 
granules would be returned. This is not only cumbersome to the Data Center but cumbersome for 
you to organize and try to review several hundred thousand data granules. EDC runs a model that 
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uses search criteria and data set information (if available) as you enter it to calculate an estimated 
time required to run the search. If this estimate exceeds a certain time (the wall) the search will 
not run. In this case you will receive a message asking you to narrow the search criteria, and you 
must organize the search to chop it up into manageable sizes. 

4.6.3.2.3.4 Save Inventory Results 

Inventory Results may now be saved, and written to a file or mailed to you at your request. This 
option is available from the Screen Functions menu located in the menubar at the top of the 
Inventory Results screen. 

4.6.3.3 Entering Search Criteria 

Information may be manually typed into a field by moving the cursor to that field and beginning 
typing. Use the mouse to move the cursor to the appropriate field and click the select (left) 
mouse button. (This will create a bold border around that box.) You may then type the valid 
information into that field. 

Some of the fields have bottom and right scroll bars to scroll left and right, and up and down. 
Using the select (left) mouse button users will be able to change the view by moving the slider 
up and down (or side to side) in the scroll area or by pressing one of the scroll arrows. 

4.6.3.3.1 Valids Lists 

If you are not familiar with the valid values for a field, the Valids List can be used. This list 
contains the items that are valid values for that field. The B0SOT employs a system of dependent 
valids where the values displayed in the Valids Lists are narrowed based upon values that have 
already been chosen in other Dependent Valids fields. These fields include, Data Center, Data 
Set, Parameter, Platform/Source, Instrument/Sensor, Campaign/Project, and Processing Level. 
For example, if you had already specified a data center, then clicked on the List button next to 
the Data Set ID field, the data sets listed in the Valids List box would only be the data sets 
available from that single specified data center. 

Any incompatible selections will have an asterisk (*) placed before it. For example, if you were 
to choose two data centers, and then choose a dataset from only one data center, the system 
would then show the other data center with an asterisk indicating that it is incompatible with the 
further selection of the data set. 

When selecting valids, move the cursor to the List button for the field in question, click and a 
Valids List window will appear. The name of the field to which this list corresponds will be in 
the upper left corner. 

There are two large display areas. The one on the left displays all the compatible values. The one 
on the right displays the selected values. 
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The buttons on the screen have the following functions: 

Filter Displays the list of available predefined filters for this field. E.g., choosing the 
Altimeter filter from the sensor valids list will display only compatible 
altimeters in the display area on the left. 

Add All	 Adds all the values listed in the display area on the left to the display area on 
the right, i.e., from All Compatible ... to Selected ... 

Add	 Adds the highlighted value(s) in the display area on the left to the display area 
on the right, i.e., from All Compatible ... to Selected... 

Remove Removes the highlighted value from the display area on the right (Selected ...). 

Remove All Removes all the values from the display area on the right (Selected ...). 

Help Displays the help for this screen in a pop-up window. 

Definition	 Displays a definition of the last highlighted value. Only one definition at a time 
can be displayed. 

Cancel Returns you to the Search screen without retaining any of the changes. 

OK Accepts any inputs and returns you to the Search screen. 

4.6.3.3.1.1 Making Selections 

To make the desired selection(s), click on a valid in the box to the left labeled All Compatible ... 
and then click on the Add button. The selection will then appear in the box to the right labeled 
Selected ... . Double clicking on an item will also add it to the list on the right. Click on OK to 
return to the Search screen. 

To select values for a given field from the Valids List, click on each item. 

To select multiple values for a given field from the valids list, select the first item by clicking the 
on that item. Hold down the CONTROL key and use the mouse to click on the other items. Note: 
the CONTROL key must be pressed for each subsequent choice or the previous selections from 
the list will be lost. To deselect any single item when several items are already selected, hold 
down the CONTROL key and click on the item to be deselected. If the CONTROL key is not 
used, all the selected items on the current page will be deselected and the item that was clicked 
on will be selected. 
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4.6.3.3.1.2 Using Filters 

Predefined Filters are predefined subsettings of the valid values. For example, choosing the 
Altimeter filter from the sensor valids list will display only compatible altimeters in the display 
area on the left. To view the list of filters, click on the Filter button and a pop-up window will 
display the list. Click on a filter and then click on the OK button. The name of the filter will now 
be shown above the display area on the left side of the Valids List window and the values that 
are displayed will be those that are compatible with the filter and any other choices you have 
made in other dependent valids fields. 

Type-in field 

The Type-in field allows you to type in a valid value, or an accepted alias, or to use a wildcard. If 
a valid value or an alias that maps to only one valid value is typed-in, then the value is 
automatically selected and displayed in the display area on the right side of the Valist List 
window. If a wildcard or an alias that maps to more than one value is typed-in, then the matching 
valid values are displayed in the display area on the left side of the screen, so that you can choose 
any or all of the matching valids. 

You may omit blanks and special characters in the typed-in value; if they are included, the 
system will check for them. Capitalization is not significant. 

The system provides a feature called "wildcarding." This allows you to type part of the entry and 
use a "wildcard character" for the rest of the entry. 

To use the "wildcard" feature, type into input area beneath the display area on the left side of the 
screen, and press RETURN. The alias used will be shown above the display area of the left and 
the values that are displayed will be those that are compatible with the wildcarded entry and any 
other choices you have made in other dependent valids fields. 

Where you place the asterisk is of importance. Whether or not there is a blank space between the 
word and the asterisk is meaningful. It can result in differing values that are displayed for you. 

The system allows the following formats: 

• ice* - matches all valids whose first three alphabetic characters are ice. 

• ice * - matches all valids whose first four characters are ice then a blank. 

• *ice* 

• * ice * 

• * ice* 

• *i ce * 
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The system does not allow the following formats: 

• *ice 

• * ice 

4.6.3.3.1.3 Definition 

The system allows you to access definitions of terms in the Valids List window. Highlight the 
term and click on the Definition button. A Definition screen window will appear containing the 
definition. 

The buttons on the Definition screen window have the following functions: 

OK Returns you to the Valids List window. 

Guide Info Displays detailed information relevant to the defined term. 

Help Displays the help file for the Definition screen window. 

From the Definition screen window, you may request to see Guide documents that are associated 
with that term. The system assumes that you are requesting specific document types (i.e., 
platform documents, instrument/source documents, etc.). This request is more specific than a 
Guide type search executed from the Search screen. 

Two fields do not provide the Guide Info function from the Definition screen window from the 
Valids List window. These are Parameter and Processing Level. Currently, there do not exist 
parameter or processing level type documents. The Guide Info button is grayed-out and, 
therefore, unavailable from these two screens. 

4.6.3.3.2 Geographic Options Selection 

To specify a geographic area selection, move the cursor to the upper right hand area of the screen 
and place it on the Geographic area selection box. To display the different options for specifying 
a Geographic area, press and hold down the mouse button. If you choose Global Search, the 
coordinates will be loaded and displayed in the Geographic area of the Search screen. 

4.6.3.3.2.1 Selection Map 

The system will graphically display the map of the world in Plate-Carree (flat world map), North 
and South Pole stereographic projections at your choice and will allow you to select the area of 
interest for search criteria entered in the Search screen. 
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Map Options 

•	 Change the type of projection by choosing corresponding option menu item from the 
Projection option menu in the upper-left corner of the screen. The zoom factor as well as 
an area previously marked on the map is kept consistent for any map projection. The 
center latitude and longitude of the map projection can be changed by dragging the 
latitude and/or longitude sliders located on the bottom and right-hand sides of the map. 

•	 Real-time panning repositions the map center in either projection in both longitudinal and 
latitudinal directions. This function is provided by vertical and horizontal sliders located 
to the right and at the bottom of the map respectively. For North-Pole and South-pole 
stereographic projections the Earth can be viewed at any angle making it a general 
stereographic projection. The values of the center longitude and latitude in degrees are 
displayed in the text boxes next to the arrows at the top and on the left hand side of the 
map. 

•	 Real-time zoom allows you to increase or decrease the viewable area of the globe for 
greater map detail or broader view. The map resolution will automatically enhance as you 
zoom in giving more map detail. The zoom control slider is located to the left from the 
map. 

•	 Toggle the map layers and grid lines This allows you to display/hide the political 
boundaries and rivers on the map and also to choose the grid lines increment in degrees. 
These functions are accessible from the Screen Functions menu. 

Drawing Functions 

The Drawing Functions group is found in the upper-left corner of the screen. Clicking on one of 
the four toggle buttons will select the desired marking function. After it has been selected you 
can move the cursor into the map area and mark the area of interest by clicking and/or dragging 
the cursor. The latitude/longitude value text label will be dynamically shown next to the cursor 
position to help you determine the current cursor location. Marked point(s) lat/lon values will 
then appear in the text fields in the bottom of the screen and on the Search screen. There are four 
different ways to mark a region of interest: 

•	 Point allows you to select a single point on the map. To select a point, move the cursor to 
the desired position and click the left mouse button. The dot and the lat/lon label next to it 
will show the marked position. The lat/lon values will also be displayed in the text fields 
in the bottom of the screen. 
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•	 Rectangle allows you to select a range of latitude/longitude values which delimit a 
rectangular area on the map. To mark a rectangle you must first position the cursor in the 
map, press left mouse button and drag the cursor to the destination point holding the left 
button down. The rectangle on the map will dynamically grow or shrink until you release 
the button. When the button is released the corner point values of the rectangle will 
appear in the text fields in the bottom of the screen and in the Search screen. The area is 
now selected. To edit the area you may position the cursor at another location on the map 
and repeat the operation until satisfied with the selection. The starting point (the point 
where the mouse button was first pressed) will remain the same. 

•	 Range is very similar to rectangle with one exception: The location where the mouse 
button was first pressed will be the center point of the selected rectangular area. The red 
dot and a text label next to it will show the lat/lon position of the center of the rectangle. 
You may edit the area by positioning cursor near any corner point of the rectangle, 
pressing the left mouse button and dragging the cursor. The area will re-shape following 
cursor movement until the mouse button is released. The lat/lon values of the corner 
points as well the latitudinal and longitudinal range will be displayed in the text fields 
below the map. 

•	 Polygon allows you to select an area delimited by a four-corner polygon. The cursor 
must be positioned at the first desired point. Press left mouse button and drag the cursor 
to the position of the second point and release the button. The line between two points 
will show on the map. Press the button again near the second point and drag the cursor to 
the location of the third point, then release the button. The line between second and third 
points will be drawn. Press the button again near the third point and drag mouse to the 
location of the fourth corner. The polygon will close and will be re-shaping following the 
mouse movement until the button is released. The polygon is marked. Now it is possible 
to edit the location of any corner by positioning the cursor near corresponding corner 
point, pressing left mouse button and dragging cursor to a new location. 

Note: There are some limitations on the polygonal area shape. Namely, it must be convex and 
must be marked in clockwise direction. The marking algorithm will not allow points in counter 
clockwise direction or non-convex shapes. It is also possible to mark a region covering a pole. 
The same rules for shape and order of the points apply. 

The selected area points' coordinates will be shown in the boxes at the bottom of the screen and 
in the Search screen. After the area has been selected you may go back to the Search screen. The 
selected area boundaries will be reflected in the geographic area box. 

The buttons at the bottom of the screen are shortcuts for commonly used commands. The Search 
Screen button closes the Coordinate Selection Screen and returns back to the Search screen. The 
Clear Selected Area button cancels the selection. This can also be achieved by choosing another 
Drawing Function from the Drawing Functions box. The Close button closes the screen. 
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4.6.3.3.2.2 Geographic Area Caveats 

The Directory search capability allows geographic searches by the following search types: 
Rectangle, Select from map, and Global granules only. 

The following Data Centers do not support corner point searches: JPL, LaRC, GHRC and 
NOAA-SAA. In these cases, if you specify a search by entering Polygon points, these Data 
Centers calculate the bounding rectangle and then run a rectangle search. You will be notified 
that these Data Centers revised the geographic search criteria. This message will be standard 
across all these Data Centers. Data Centers will put the requested fields in the "fields not 
mapped" area since, in this case, the Data Centers aren't really mapping your input directly into 
their database. 

4.6.3.3.3 Date and Time Ranges 

There are two different types of time ranges available. You can specify a continuous time range, 
or an annually repeating time range (e.g., the last 10 summers). Specifying Date/Time criteria is 
optional. 

4.6.3.3.3.1 Continuous Time Range 

Enter the start and end dates and times of the continuous time range of interest in the Start 
Date/Time and End Date/Time fields. The format is YYYY-MM-DD for the date, and 
HH:mm:ss.ss for the time. If a time is not entered, the start time will default to the beginning of 
the day (00:00:00) and the end time will default to the end of the day . 

4.6.3.3.3.2 Annually Repeating Time Range 

Enter the start and end dates and times of the temporal range over which the annually repeating 
time period should be repeated. The format is YYYY-MM-DD for the date, and HH:mm:ss.ss 
for the time. If a time is not entered, the start time will default to the beginning of the day 
(00:00:00) and the end time will default to the end of the day . 

You must also specify the start and end dates for the interval. The format is the Julian date 
(DDD).The Help file provides a list of Julian dates for a regular (not a leap year) calendar year. 

If a scientist wanted information for the last 10 summers, the start and end dates would be 1986­
06-22 and 1996-09-21. This covers the 10-year span. To specify summer, the scientist must enter 
the Julian date range. The beginning date would be represented by 173 and the ending date 
would be represented by 265. 

4.6.3.3.4 Save and Restore of Search Criteria 

You can save search criteria for later retrieval. After entering the search criteria, select Save 
Search from the Screen Function menu. In the GUI, you may also click on the Save Search 
button. The system will pop-up a window prompting you for a name to be entered for the search 
criteria. 

4-23 205-CD-004-001




To retrieve search criteria that has already been saved, select Retrieve Search from the Screen 
Functions menu. You may also click on the Retrieve Search button. The system will bring up a 
window with all the search files that have been stored. Selecting one of these files will result in 
the system retrieving that search criteria and displaying it on the screen. 

If a set of search criteria is saved and named default, that search criteria will be automatically 
loaded into the Search screen each time a new session of B0SOT is begun. 

If you are running the client from your own local machine, a mechanism is available to specify a 
search criteria file load from the command line. (See the EOSDIS IMS Installation Guide 
available from the EOSDIS IMS Home Page) for details. 

4.6.3.4 Results 

4.6.3.4.1 Guide Search Results 

The Document Score 

When results are first returned, there is a list of document titles preceded by a score. The score is 
normalized to 1000 where 1000 is the highest score. A high score means that the document came 
close to matching the search criteria. For example, there is an SSM/I sensor document and there 
is a DMSP-F8 platform document that mentions the SSM/I sensor. If the query is for 
sensor=SSM/I, the SSM/I sensor document should get a higher rating because it would have the 
word "sensor=SSM/I" more times than the platform document. The other document will return 
but with a slightly lower rating. 

Viewing Guide Documents 

From the document list you can click on the document name to view that document. This will 
bring up a Guide document. Items that are highlighted indicate that there are supporting 
documents available that may be of interest. To access these click on the highlighted item. There 
may be some in-line graphics or images. To improve performance, some images were included 
in-line as a "postage stamp" size version. If you click on the image, the system will bring up a 
full size image. You can go "back" to the previous document. To go back further than the last 
document, keep clicking the Back button, or use the History List option available under the 
Screen Functions menu. The Find button allows users to search for word(s) in the current guide 
document. For example, if you enter the word "platform", and either presses the RETURN key or 
clicks on the Find button, a search through that document will be done. 

The cursor will go to the first occurrence of the word "platform" in the Guide document. 

The Document History List 

This Document History not only lists all of the documents seen, it also lists the documents that 
you can go forward to based on the hyperlink information in the "current" document. It is 
available from the Screen Functions menu bar options. To select an item from the History List, 
position the cursor over the item and double click. 
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4.6.3.4.2 Directory Search Results 

Once a search is executed, the system will respond with a Communications Results Status screen 
that will inform you of the searching and network activity. A completed search at a data center is 
indicated by the button labeled Data next to the particular data center being bolded. After all 
searches have completed, you can view the data received. You can click on the Data button. In 
the case of a problem with a particular Data Center, View the Comments. 
Once a search is performed, you will be provided with menu bar options to view: 

• Data set Brief Description 

• Data set References 

• Data set Personnel 

• Data set Archive Information 

• Data set Attributes which include (but are not on a menu): 

− Directory Entry Identifier


− Directory Entry Title


− Director y Entry Start and Stop Date


− Sensor Name


− Source Name


− Originating Center


− Campaign or Project


− Storage Medium


− Parameter Measured


− Discipline Keywords


− Coverage


− Location Keywords


− General Keywords


− Revision Date


− Science Review Date


− Future Review Date


− Quality
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Data is automatically sorted by data center. The system displays the data sets of only one archive 
at a time. The order of the archives is the same as that displayed on the Results Screen. You may 
display the data sets of a different Data Center by using the Next Data Center option. To select a 
data set for display of its Detailed Information, click on the Count button located to the left of the 
data set name, and then click on the Detail Directory button at the bottom of the screen. 

4.6.3.4.3 Inventory Search Results 

Once a search is executed, the system will respond with a Communications Results Status 
window that will inform you of the searching and network activity. A completed search at a data 
center is indicated by the button labeled Data next to the particular data center being bolded. You 
can click on the Data button. In the case of a problem with a particular Data Center, you should 
click on the View Comments button. 

4.6.3.4.3.1 Inventory Results Screen 

A completed search will generate Inventory Results which are organized by Data Center 
(primary sort) and Data set (secondary sort) by default. Inventory Results screen includes data 
set level information such as 

• Data Center 

• Data set Name 

• Source 

• Sensor 

• Number of granules returned for this data set 

It also provides granule summary information including 

• Sort criteria 

• Northernmost Latitude 

• Easternmost Longitude 

Start date and time for this granule, the flag that denotes whether or not a browse product or 
coverage are available for this granule, and if the granule has been marked for Order, Browse, 
Detail information or Coverage 

Results may be reorganized by using the Sort By option under the Screen Functions menu. Users 
may indicate both a primary and a secondary sort key. 

Also, you may mark granules for Detailed information, Order, and, if Browse and/or Coverage is 
available, set the flag to "Y" to mark for Browse or Coverage. 
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4.6.3.4.3.2 Detailed Inventory Information 

Once you mark a granule(s) for Detail, those Inventory details may then be accessed. From the 
GoTo menu select Detailed Information, then for Granules from the cascading menu. The 
Detailed Inventory Information for the marked granules will be displayed one granule at a time. 
This screen includes the Additional Information field which is data set specific information that 
the Data Center staff deemed important information for you to view in deciding whether or not to 
request a granule. 

4.6.3.4.3.3 Selection List 

The Selection List option provides the capability to view only those granules that you have 
selected (or highlighted). 

Using the Selection List 

Going between the Inventory Results List and the Selection List works much like a toggle. On 
the Inventory Results screen, there is a Selection List button at the bottom of the screen in 
addition to a Selection List option in the Screen Functions menu. When selected, you will see the 
same screen (it will repaint) but with only those granules selected. On this Selection List screen, 
there is an Inventory Results button at the bottom. 

Marking 

You can "mark" granules from the Selection List. Any "marking" in the Selection List will not be 
updated in the Inventory Results list until you toggles back to the Inventory Results list. If you 
are in the Selection List and "mark" granules for Detailed information, then GoTo Detailed 
Information for Granules, the system will only show the "marked" granules from the Selection 
List--not those that were marked but not "selected" in the Inventory Results list. However, when 
users go back to the Inventory Results screen, and then GoTo Detailed Information for Granules, 
they will see everything that was marked in both the Selection List and Inventory Results screens 
whether they are highlighted or not. 

Sorting 

You can only sort granules in the Inventory Results screen. But once sorted in the Inventory 
Results list, granules will appear in the Selection List in the same order. So in a sense, you can 
sort the Selection List by going back to the Inventory Results, resorting the granules, and 
returning to the Selection List. 

4.6.3.4.4 Selecting and Marking 

Selecting is not the same as Marking. Selected items may or may not be marked. Marked items 
may or may not be selected. 
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4.6.3.4.4.1 Selecting 

In the Inventory Results, to select granules, simply position the cursor on the granule of interest 
and click the mouse button. To select multiple values for a given field select the first item by 
clicking the on that item. Hold down the CONTROL key and use the mouse to click on the other 
items. Note: the CONTROL key must be pressed for each subsequent choice or the previous 
selections from the list will be lost. To deselect any single item when several items are already 
selected, hold down the CONTROL key and click on the item to be deselected. If the CONTROL 
key is not used, all the selected granules on the current page will be deselected and the granule 
that was clicked on will be selected. 

To select granules that are contiguous, select the first granule by clicking on that item. Press the 
SHIFT key and click on the last item of desired granules. The system will highlight the first item 
selected, the second item selected, and all those in between. 

In the Directory Results, click on the Count button to the left of the data set to select it. The 
CONTROL key need not be used to select multiple data sets. 

Screen Functions 

To select all the granules, use Select All Granules from the Screen Functions menu. To deselect 
the granules on all pages, use Unselect All Granules from the Screen Functions menu. 

4.6.3.4.4.2 Marking 

You can mark granules in the Inventory Results and Selection List screens for Coverage Map 
display, Browse display, FTP Browse, Detailed Information, and/or Order. You can also mark 
granules in the Browse screen for Order, and in the Coverage Map screen for Browse and Order. 
In order to GoTo one of these other options, "mark" granule(s) first. 

To mark items, focus on the Marking columns on the right side of the screen. The default value 
showing is "N". Move the mouse to the "N" in the appropriate column and row, and click on that 
"N". In the Detail Info, Coverage and Order columns, the "N" will change to a "Y" indicating 
that the granule is now marked. In the browse column, the "N" will change to "IB" for Integrated 
Browse or "FB" for FTP Browse. If Browse is not available, the system will display a message 
saying "Browse is not available for this granule." Click the OK button on the pop-up to continue. 

Important note: Marking and GoingTo Browse or Coverage Map performs the action on the 
granules that are "marked". Whether they are "selected" has no bearing. E.g., you have three 
items "marked" for Browse in the Inventory Results List but not "selected", and four items 
"marked" for Browse in the Inventory Results List and they ARE "selected". If you go to GoTo 
Browse there will be seven Browse items. Then, still at the Inventory Results screen, if you 
"mark" five more items for Browse, then use GoTo Browse, there will be twelve Browse items. 
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Screen Functions 

You can also mark items by way of the menu bar. Select the items then choose Mark... from the 
Screen Functions menu. To unmark items by way of the menu bar, select the items then choose 
Unmark... from the Screen Functions menu. 

4.6.3.5 Coverage Map 

The coverage map screen provides a graphical representation of the geographic coverage of 
selected inventory granules. At your choice, the world map can be displayed in two projections: 
Plate-Carree (flat world map) and Stereographic (globe). The following controls over map 
appearance are provided: 

•	 Display or hide the lakes and rivers, political boundaries and a lat/lon grid lines with a 
given interval. 

•	 Position the map by clicking the left mouse button at the location of the mouse in the 
map. The map will center on the point where you clicked. 

•	 Display the back (invisible) face of the globe in dimmed colors for the stereographic 
projection. 

•	 PAN (or "spin") the globe in a north, south, east, or west direction at increments in real 
time. 

•	 ZOOM in or out in real time. The map resolution will automatically adjust giving you 
greater detail for zoomed-in views. 

•	 Sequentially cycle through and display the granules that are marked for coverage from 
B0SOT 

• Inventory Results screen, one at a time. 

•	 Mark "Retain Granule Current Coverage", a granule to remain displayed on the map 
while stepping through the other granules. 

• Choose to mark a granule for order, for any granule displayed on the map. 

•	 Choose to mark a granule for browse, for granules which have browse products 
associated with them. 

• Delete (hide) a granule from results list. 

In addition, the following information is displayed in the text fields in the upper-left corner of the 
screen: data center - originator of the granule, data set name, granule ID, date/time, geophysical 
parameters of the product, and the availability of an integrated and/or FTP browse product for 
this granule. 
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The buttons at the bottom of the screen are shortcuts for the most commonly used commands. 
The Next Granule button will take you to the next granule that was requested. The Previous 
Granule button will take you to the previous granule that was selected. The Coverage 
Description button will display a description of the currently displayed coverage for better 
understanding of the coverage details. The Close button will close the current window, or if no 
other windows are open, it allows you to exit B0SOT. 

4.6.3.6 Browse 

This function allows you to "see" their data before ordering. 

4.6.3.6.1 Local (FTP) Browse 

This function allows a B0SOT user to locate and retrieve browse products for selected B0SOT 
datasets for use with other viewers. B0SOT DOES NOT display these products. Instead, you 
must use whatever display tools are available on their machine or at their facility. The User 
Profile must contain first and last names and an e-mail address to run the search. 

Local (FTP) Browse Operational Scenario 

You perform an Inventory search (which may or may not include the request to see only those 
granules for which browse products exist). The system returns results including a field called 
"Browse Available," which indicates whether a browse product exists for a given granule. This 
information is displayed on the results screen for further action (where further action may be to 
see a coverage map, a browse product or delete a granule or group of granules). If you want to 
see browse products for any number of granules, then they must be marked for FTP Browse. 
Once the granules are marked for FTP browse and that function has been executed, the 
granule(s) unique identifier information is passed by B0SOT to the Data Center. The Data Center 
should send back a quick acknowledgment message to B0SOT indicating that they received the 
request for browse data. This acknowledgment message will also indicate that you will be 
receiving detailed instructions for browse data access and point of contact information via e-mail 
as soon as the browse products are on-line and ready for transfer. 

The Data Center will make the browse product available in an anonymous FTP account on the 
Data Center host machine in at most 24 hours. The product will be put in a directory within the 
anonymous FTP account. As soon as the browse products are available, the Data Center will 
send an e-mail instructing you where to find the browse data and how to access the product via 
FTP. This notification will contain the account information, directory name, the file name(s) of 
the product(s) and their associated file types and sizes. If the browse product metadata is also 
available via the anonymous FTP account, then the Data Center will include the directory from 
where these files could be copied. The product will be available in this account for 72 hours 
following the initial 24 hour period. You are responsible for determining whether your host 
machine has adequate disk space to hold the browse products; to log onto the correct Data Center 
machine(s) to access the browse product(s); to traverse to the correct directory indicated by the 
browse results e-mail message then type: get < browse_product_name > (to transfer one file) 

or 
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mget < wild card character > (to transfer multiple files) and to obtain the software necessary for 
displaying the browse products on their local workstation. 

4.6.3.6.2 Integrated Browse 
This screen allows you to view browse raster images that represent the data product(s) of interest 
and order data products for selected B0SOT data sets without use of special graphics equipment. 

This feature allows you to look at product(s) represented by raster images with the pallet that was 
sent with the product. You can pan the browse image in vertical and horizontal directions; zoom 
in/out to see greater image detail; view additional images (layers) in the HDF file if they are 
available; order the data granule represented by the image; or see the product metadata. You can 
also save the file for viewing with other software (if the client is running on your own 
workstation). 

When a regional image is displayed, the screen will also display the following: 

A small coverage map showing exactly where the image falls on the Earth. The outer blue 
polygon delimits the coverage by this product, while the inner red polygon shows the viewable 
area of the image that is currently shown in the image area. The inner box will shrink/grow with 
the zoom change. It will also move within the coverage box according to the panning sliders 
positions. For global granules, only a blue circle surrounding the globe will be shown. You can 
also pan the world map independently of the browse image to see other areas. This may be useful 
to determine the location of the coverage area if it is too small. The panning of the map is 
achieved by dragging the lat/lon sliders located at the sides of the map. 

• Data center - originator of the granule 

• Data set name 

• Granule ID 

• Date/Time 

• Parameters of the product 

The buttons at the bottom of the screen are shortcuts for the most commonly used commands. 
The Next Granule button will take you to the next granule that was previously requested. The 
Previous Granule button will take you to the previous granule that was selected. The Browse 
Request Status button will take you to the Browse request Communication Status screen. The 
Description button will display a description of the current browse selection. The Legend button 
will display a color legend of the current browse selection. The Next Layer button will take you 
to the next layer of the browse image that is currently displayed. The Previous Layer button will 
take users to the previous layer of the current browse image that is displayed. The Layer List 
button will display the list of image layers for the granule. The Close button will close the 
current window, or if no other windows are open, it allows you to exit B0SOT. 
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Integrated Browse Operational Scenario 

You perform an Inventory search (which may or may not include the request to see only those 
granules for which browse products exist). The system returns results including a field called 
"Browse Available," which indicates whether a browse product exists for a given granule. This 
information is displayed on the results screen. You can see a coverage map, a browse product, or 
delete a granule or group of granules to refine the search. If you want to display browse products 
for the granule(s), then all of the granule's ID information (the Data Center, data set and granule 
triplet) and browse method will be written into a browse request message and sent to the 
appropriate Data Center(s). 

At this point, you have the option to choose method of browse - "Integrated Browse" or "FTP". 
The "Integrated Browse" option means that all browse products available for display would be 
requested from the Data Centers(s) for display B0SOT. "FTP" would mean that you want all 
products staged by the Data Center(s) and placed in Data Center anonymous FTP accounts for 
later transfer. If you want to display browse products for the granule(s), then all of the granule 
identifier information and method of browse (Integrated Browse or FTP) is passed to the 
appropriate Data Center(s). The Data Center(s) send the browse products back to B0SOT in HDF 
format. B0SOT has a Browse 

Status screen indicating which browse product(s) have arrived. Once all images are physically on 
the B0SOT machine, the status screen will bold the Image button on the right side of the screen, 
and you will be able to see the image displayed on the Integrated Browse Product Display 
screen. This system displays one product at a time. You may step through products from 
different datasets and from different Data Centers without any special procedures to otherwise 
traverse these. 

If you select a granule for browse that has more than one image associated with it, the images 
will be viewable. A set of buttons next to the bottom left corner of the browse image will become 
activated (bold). 

4.6.3.7 Order Data 

Information pertaining to orderable data products will be displayed for you. A dialog can then be 
established through the interface with individual Data Centers to make a data order. The User 
Profile must contain at least first and last names, city, country, phone number, Internet e-mail 
address, and affiliation category and type. 

Data Subsetting 

Basic data subsetting is indicated at the bottom of the Package Options screen. Currently, only 
temporal and spatial are supported. Availability of this feature differs among data sets and data 
centers. Available options are in black, unavailable options are greyed out. 
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Order Data Operational Scenario 

There are two ways to mark granules for Order from the Inventory Results screen. You can 
select the granule(s), choose Screen Functions from the menu bar, and then choose Mark... for 
Order from the cascading menu. Or you could click and toggle from N to Y in the Order column 
on the right side of the Inventory Results screen. 

If a granule is "packaged" one per package, users will be able to mark/unmark for Order. Here 
the granule marked/unmarked is packaged together with other granules, then the Member 
Granules screen pops-up showing all the other granules from the current search that are packaged 
together. You can mark/unmark all these granules together by clicking on the OK button at the 
bottom of the Member Granules screen. Clicking the Cancel button will not alter the previous 
markings. From here, you should select the GoTo menu, and then choose Order Data. Here the 
user's selected packages are displayed so that you can specify the processing and media options. 
To select the options, click on the particular package, then click on the Package Options button. 
The system will bring up the Package Options Selection screen for the package. Make selections 
and click on the OK button. 

Note: If this operation is performed on the first package in the list, you may choose the same 
option for the rest of the unselected packages. The default is to mark all. 

Use the Next Data Center and Next Data Set buttons to progress through all the marked granules, 
until a pop-up appears that says "No more Data sets.". Click on the OK button in the pop-up 
window to close it and return to the Order Data screen. 

There is a Duplicate Order button for submitting orders of more than one copy of an order for a 
particular data set. To submit the Order, you should select the Screen Functions menu and then 
choose Submit Order, or click on the Submit Order button at the bottom of the screen. The Order 
Data Search Status screen will appear. After successful completion of an Order, the data centers 
send back the contact information. This may be viewed by clicking on the Contact Information 
button for each data center. 

4.6.3.8 Comments 

Comments Description 

The Comments function will allow you to create comments to send to the B0SOT system staff. 
You are encouraged to send comments at any time. This function will access a line editor in 
which users may create a comment. You may save the comment and later access it to add further 
comments throughout B0SOT. The Comment will be sent upon exiting B0SOT . 

To access this function, first go to the User Profile and fill out the user information. After doing 
so, return to the Go To Menu bar and select Comments. Move the mouse to the text area and 
click the left mouse button. You may now type in the comment. The up and down Arrow keys 
can be used to move between lines of text. When you are finished, click on the Close button, or 
click on the Send Comments button. 
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The Close function will save the comment and allow you to leave Comments without sending it. 
If you have already sent the comment, Close will return you to the previous location in the 
system. 

Comments Caveats 

The User Profile must contain at least first and last names, city, country, phone number and 
affiliation category and type. Please include an Internet e-mail address. 

4.6.3.9 System Limitations 

To view an updated listing of the system's limitations and known problems, go to the Welcome 
screen and access the hyperlink. 

4.6.3.10 Command Definitions/Descriptions 

The following table contains command definitions and descriptions for B0SOT. 

Table 4-2. Command Definition and Descriptions 
Command Definition/Description 

Abort Search Aborts all searches that are not complete. Information returned from completed 
searches will be available for display. 

Arrow keys Move one space at a time or one line at a time. 

Browse This option will provide access to browse products for selected granules (those 
"marked-for-browse). 

Cancel Cancels the current action. If you are in a pop-up window, this will take you back 
to the previous screen without accepting any information that you into the pop-up 
window. If you are in a screen (e.g., comments or user profile) cancel will put you 
back where you were before you entered this screen. 

Clear Field Clears the input from the field at which the cursor is located. 

Clear Form Clears the entire screen. 

Click Quickly press and release the mouse button. 

Comments Allows you to generate comments. Upon entering this screen you can begin a 
comment or add to previous comments (if you have already started one). You 
may call this up anywhere throughout the system for re-editing. Your comment 
will be sent to the B0SOT staff upon exiting the system. At any time during your 
B0SOT session, you may send the comment. 

Contrast/Brightness Allows you to adjust the contrast and brightness by using the mouse to move 
sliding scale bar. 

Copy from Billing Copies address information from the Billing contact information that you supplied 
in the Billing form to the form currently on the screen. This is only available from 
the user profile screen when you are at the User or Shipping form. 

Copy from Shipping Copies address information from the Shipping contact information that you 
supplied in the Shipping form to the form currently on the screen. This is only 
available from the user profile screen when you are at the User or Billing form. 
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Table 4-2. Command Definition and Descriptions (cont.) 
Command Definition/Description 

Copy from User Copies address information from the User contact information that you supplied 
in the User form to the form currently on the screen. This is only available from 
the user profile screen when you are at the Billing or Shipping form. 

Coverage Map Provides a coverage map indicating the general location of a specific granule on 
the globe. 

Data Center 
Information 

Provides information about the data center holding the data set, the unique 
identifier used by the data center to point to the data set, and a person to be 
contacted at that center for information on data access. 

Data set Attributes Provides high-level information on various attributes of the data set including 
Directory Entry Identifier, Directory Entry Title, Directory Entry Start and Stop 
Date, Sensor Name, Source Name, Originating Center, Campaign or Project, 
Storage Medium, Parameter Measured, Discipline Keywords, Coverage, 
Location Keywords, General Keywords, Revision Date, Science Review Date, 
Future Review Date, and Quality. 

Data set Brief 
Description 

Provides a high-level summary about the data set. 

Data set Personnel Provides information about the Investigator, Technical Contact and Author 
associated with the current data set and textual description. The Investigator is 
the person who headed the investigation or experiment that resulted in the 
acquisition of the data described. The Technical Contact is a person who is 
knowledgeable about the technical content of the data (quality, processing 
methods, units, available software for further processing, etc.). However, please 
call the associated Data Center first as they also have knowledgeable staff who 
can answer many of your questions. The Author is the person responsible for the 
accuracy of the information content of the data set textual description. 

Data set References Provides a few key bibliographic references pertaining to the current data set. 

Directory Information Retrieves brief a textual description about the data set associated with the 
selected granule. If a previous directory search was performed and the directory 
information is readily available, the information will be displayed immediately. If 
the granule does not have directory information readily available, the system will 
perform an automatic directory search. 

Del Backspaces by deleting one character at a time. 

Exit B0SOT Exits the B0SOT system from any location in the system. You will be prompted f 
you really want to leave the system before completing the exit. 

Grid Toggles gridlines on or off the browse or coverage display. 

Grid Interval Allows you to set the grid interval between 5 and 45 degree increments. 

Help on Commands Provides definitions and information on the various commands available through 
the menu bar. 

Help on Functions Provides definitions and information on the various functions available through 
the menu bar. Example functions include sending comments about the system, 
accessing the user profile, directory, inventory, coverage, and browse 
information, and requesting and ordering packages. 
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Table 4-2. Command Definition and Descriptions (cont.) 
Command Definition/Description 

Help on Screen Invokes help menu on the current screen. 

Help Select Item Invokes help on the field on which the cursor is located. 

Help on System Provides descriptions and information on various aspects of B0SOT. 

Inventory Details Displays detailed information about specific granules. This option is available 
from the Inventory Results screen. Once you have selected specific granules and 
have marked them for inventory details, this menu option will display the granule 
details. 

Inventory Information Retrieves granule level information associated with all selected data sets. 

List Brings up a list of Valids for a particular field. In the valids list you use the up and 
down Arrow keys to move through the list. Click to select keywords. You may 
select as many as you like. When you finish making your selection, select OK to 
accept the information, or Cancel to cancel the information. 

Mark for Order Allows you to select granule(s) for request. To finalize your request and submit it 
to the Data Centers, you must go to Order Data to provide specific order 
information before you exit B0SOT. 

Mark for Browse Allows you to select a granule(s) for viewing associated browse products. This 
option can only be exercised if the Browse Available flag is IB for integrated 
browse or FB for FTP Browse. 

Mark for Detail Allows you to select a granule(s) for detailed inventory information. Once you 
make this selection you GoTo Detailed Information to access the detailed 
information. 

Next Data Center Displays information for the next Data Center when information from multiple 
Data Centers is available. This is available at the Inventory Results when data 
are organized by Data Center and Data set. 

Next Takes you to the next "group" of information. For example in the Inventory 
Results, granules are organized by "sort key". Available "sort keys" include Data 
set, Archive, Source, Sensor, and Archive and Data set (default). In these cases, 
it will take you to the next lowest level "sort key" unless you are at the last. By 
lowest level, we mean if there are multiple sort criteria (e.g., in the case of 
Archive and Data set) the lowest level would be the secondary sort key (in this 
case, Data set). When there are multiple sort criteria there is a separate key to 
sort the primary key (e.g., ESC-k for Next Archive). Note: The item name "Next " 
as it appears in the menu bar changes depending on the current sort key. 

Ok Accepts input and integrates the information into the screen display. 

Order Data Allows you to create a request for data based on granules that you marked-for­
order. It will provide you options for data packaging, format and media. Your 
request may subsequently be sent to the Data Centers. 

Political Boundaries Toggles the political boundaries on or off the browse or coverage display. 

Previous Takes you to the previous "group" of information. 

Remove Granules Allows you to hide all granules selscted from the Inventory Results list. 

Restore Deleted 
Granules 

Allows you to re-display all granules that had been hidden from the results list. 

Rivers/Lakes Toggles lakes and rivers on or off the browse or coverage display. 
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Table 4-2. Command Definition and Descriptions (cont.) 
Command Definition/Description 

Search Takes you to a search screen from other screens in the system. OR Executes a 
search if you are already at the search screen. 

Sort by Allows you to sort the list of granules returned from your search. The default is a 
primary sort by Archive and a secondary sort by Data set. Other sorting options 
available through the "Sort by" option include by Data set, by Source, by Sensor, 
by Start Date/Time, and by Archive. 

Sort by Data Center Sorts the entire list of granules by Data Center. 

Sort by Data Center 
and Data set 

Sorts the entire list of granules by Data Center (primary sort), then by Data set 
(secondary sort). When granules are organized this way, the Next Data set 
option will move within data sets at one data center. To get to data sets at other 
data centers you must first do Next Data Center. 

Sort by Data set Sorts the entire list of granules by Data set. 

Sort by Sensor Sorts the entire list of granules by Sensor. 

Sort by Source Sorts the entire list of granules by Source. 

Sort by Start 
Date/Time 

Sorts the entire list of granules in chronological order based on the beginning of 
data collection by the sensor. Keep in mind that some data granules may span 
days, weeks, months... so the time represented by the data granule is not 
necessarily instantaneous. This feature is helpful in finding coincident data. 

Status Takes you to the Results Status Screen and displays the status of your last 
search. 

Tab Moves from field to field. 

User Profile Takes you to the User Profile Screen where you can specify contact information 
and set your preferred work environment. 

Welcome Takes you back to the initial screen in B0SOT. 

Zoom Expands the detail of information. 
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4.7 Earth Science Online Directory (ESOD) 

ESOD serves as the directory service for EOSDIS. It provides brief descriptions of data products, 
software tools, and services. It also serves to facilitate collaborative research by allowing 
scientist to advertise their own data, software, and services. There are two ways to access ESOD: 
one is integrated into the search and order tool B0SOT and the other is directly through the 
ESOD interface. The directory entries or "ads", as they are called, include a description and, as 
applicable, key metadata to identify them. Some may provide contact information so that you 
may follow-up on and gain access to information of interest. Other ads will provide direct 
hyperlinks to the specified data product, tool, or service. ESOD also stores similar information 
about EOSDIS-sponsored data products, tools, and services. 

Here's how it works 

ESOD permits free text searching on ads as well as advanced metadata searching on dataset 
advertisements. When a you perform a free-text search, for example, "drought Iowa USA 1995," 
ESOD returns a list of ads that includes these terms in its description or title. Then, you may 
browse through the ads to identify the most relevant for your needs and access the source 
information through a hyperlink provided in the ad or using other access instructions included 
within the ad. 

4.7.1 Types of Advertisements 

There are two basic types of ads: Data Advertisements and Service Advertisements. 

Data Advertisements 

Data ads describe a collection of Earth Science data that are logically related in some defined 
way, such as being from the same instrument, being processed to the same level, revolving 
around a certain measurement, etc. 

Advertisements have descriptors associated with them. These include the platform (or satellite) 
name, the sensing instrument name, the analysis source, the campaign name, any spatial and 
temporal keywords, processing level, and the spatial and temporal extent of the collection. The 
ESOD allows users to search for data ads based on these metadata. Advertisement submitters can 
also provide additional metadata parameters to help describe the data collection. 

Service Advertisements 

Service ads describe any ads other than data ads. These ads fall into three categories: Web 
Service, Non-Web Service, and Installable Service. 

•	 Web Service ads usually advertise a web site related to Earth Science established by 
some organization. Such web sites might describe an organization, provide access to 
specific data sets, allow users to search through data archives, give instructions on how to 
download software applications, or provide any other variety of information of interest to 
the Earth Science community. These ads generally include a hyperlinked URL to connect 
to the web site. 
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•	 Non-Web Service ads usually describe resources available to the Earth Science 
community that are not accessible over the World Wide Web. This might include 
references to books or journal articles, information available by mail or telephone, or 
instructions on how to access remote systems via telnet or dial-up access. 

•	 Installable Service ads are a special set of ads that advertise software that can be installed 
by the ESOD onto your local workstation and, specifically, integrated into the EOSDIS 
X/Motif Desktop. Installing these ads requires that your workstation be properly 
configured. Performing this configuration is described on the applicable page within the 
ESOD application. 

4.7.2 To Search All Advertisements Through ESOD 

The ESOD Search All interface is a simple, free-text search engine as the screen capture of a 
portion of the HTML form below illustrates. 

Type in one or more search words in the first form field on the page and hit return. 

The search returns all data product and service advertisements containing all the search words in 
either their title or description. By default, 10 ads are returned at a time. If you wish, you may 
change these defaults by changing the selected fields in the search options portion of the page. 
When these fields are modified, you can submit the search by clicking on Submit. 

After the search is submitted, a new page will load with the search results. The results are listed 
in alphabetical order. Each item in the list shows the title of the ad, a "NEW" symbol if it is less 
than 30 days old, and an identification of the type of ad. Click on the title of any of the ads to 
load the ad itself. The contents of the ad may then be reviewed. 

Click on Next n hit(s) to retrieve the next set of ads in your search results. 

Click on either of the Save entries . . . links, to save a downloadable version of the results to your 
local machine. 

What should you do when . . . 

Your search produces no results 

First, check your spelling. If everything looks correct, then try to be less specific in your query. 
For instance, the query "AVHRR Iowa" may be too specific; the query "AVHRR" or "Iowa" may 
be more appropriate. 

Try a different word or synonym. If you are searching for ads associated with "precipitation" but 
none are returned, you might want to try other synonyms such as "rainfall" or "snowfall" as 
alternate search words. 

Don't use more than 10 search keywords, which is the current limit. 

Your search produces too many results 

Be more specific. Try to think of words that uniquely identify what you're looking for. Some 
words are of little value because they identify lots of items. 
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You get an error from the Search Tool 

The Search Tool will return an error message if it has trouble with your query. If you receive 
cryptic text or error codes, please let us know: our address is 

DAACadministrator@DAAC.xxx.xxx. 

Thanks! 

4.7.3 Advanced Search of Data Advertisements 

The Search Data interface is a specialized search engine that allows you to search the metadata 
of ads for data products. When you submit an ad for data products, you define certain metadata 
to describe these data sets. This metadata includes attribute information, such as 

• Platform and instrument name 

• Temporal coverage limits 

• Geographic coverage for the collection 

To use this form, select one or more of the attributes, temporal, or geographic criteria. 

In the Attribute Criteria section of the form, select which, if any, of the criteria you wish to 
select. For example, if you wish to limit your search to a particular Moderation Group, select that 
group. 

Under the Geographic Coverage Criteria, you may specify the bounding rectangle to enclose 
your search. This rectangle, bounded by a maximum north and south latitudes, and maximum 
east and west longitudes, defines the limits of your search area. The search will return only data 
products that have any data within this geographic region. The default selection covers the entire 
globe; however, you may reduce it to be as small as you need it. Latitudes north of the Equator 
and Longitudes East of the Greenwich Meridian are designated as positive values. Latitudes 
south of the Equator and West of the Greenwich Meridian are negative values. 

Under the Temporal Coverage Criteria, you may specify the beginning and ending dates of the 
range to enclose your search. The search returns only data products that have any data within this 
time period. 

By default, 10 ads are returned at a time. If you want, you may change this default. 

When the search criteria are completely specified, you can submit the search by clicking Search. 
After submitting the search, a new page will load with the search results. The results are listed in 
alphabetical order. Each item in the list shows the title of the ad, a NEW symbol if it is less than 
30 days old, and an identification of the type of ad. By clicking on the title of any of the ads, you 
load the ad itself. You may then review the contents of the ad. 

If you click on Next n hit(s), the next set of ads in your search results will be retrieved. If you 
click on either of the Save entries ... links, a downloadable version of the results is saved to your 
local machine. 
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4.7.4 Contribute an Advertisement - Basic Overview 

The Contributions area of ESOD allows you, a provider of Earth Science information and data, 
to advertise your resources to the Earth Science Community. The first page of this area provides 
access to a basic overview of the Contribution process and to the three functions you can 
perform: Create, Update, and Delete Directory Entries. 

ESOD accepts two basic types of ads: data ads and service ads. These ads must be a resource for 
the Earth Science community and will be available to the public. 

To ensure high quality, appropriate entries in this directory, all contributions are reviewed by a 
moderator for the group in which you place the entry. This moderator may 

• Accept without any change 

• Accept with changes 

• Reject your contribution 

In any case, you will be notified of what happens. Contributions include new entries, updating 
entries, or requests to delete entries. You determine who the moderator for a group is by looking 
at the detailed description of the group. 

Because of the moderation process, your contribution will not immediately affect the directory. 
So, you will be sent a electronic mail message containing your contribution. Keep this as a 
reference until your contribution is reviewed. You will be notified by electronic mail when it is 
accepted or rejected. 

Before you can submit an ad, you must register your organization as a provider, if it has not 
already been registered. This registration is also moderated, so it takes at least a day before a new 
provider can submit ads. Once your provider has been registered, you will be contacted via e­
mail. After your provider has been registered, you will be able to submit ads at any time. 

There are two methods to submit an ad. You may either fill out an on-line form, which should 
meet the needs of most advertisers, or you may use an FTP template for data ads and upload this 
to ESOD. The FTP template provides the opportunity to enhance your data ad with additional 
metadata entries. The template uses ESOD-specific HTML tag parts to document those portions 
of your description that relate to ECS standard attributes. These ESOD-specific tag parts reside 
in the ESOD database to facilitate searching. Primarily, providers of advanced data should 
consider using this template file. 

When you use the on-line form, you may also include HTML tags in your description. Please try 
to restrict entries to HTML 2.0 to allow everyone on the Web to see them. This allows you to 
include appropriate links to other locations, images, etc. 

Some notes on hyperlinks between entries should be emphasized. ESOD utilizes the Web's 
hyperlink facilities to clarify relationships between our entries. A given organization usually 
offers several data collections and services. A service can apply to one or more data collections. 
There are three important ramifications of these hyperlink facilities. 
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1.	 Each advertisement has a unique identifier (ID) that is used by contributors to hyperlink 
to them. 

2.	 If you wish to link together a set of ads, you should attempt to get the related ad IDs 
before contributing a data or service advertisement. 

3. If you do not get the IDs when you submit the ad, you can always modify it later. 

Finally, if you create several entries in the same session, it may seem a little complicated linking 
them together. Since they are not moderated, they "disappear" until they are approved. However, 
when they are submitted, they still get an ID. This ID will be displayed when the ad is submitted 
and in your electronic mail copy. You can use this ID to hyperlink, even though the entry isn't 
yet publicly displayed. 

4.7.5 Contribute an Advertisement - Create an Ad 

Select Provider 

The first step in creating a new ad is to select your provider. Select your provider from the list 
and press Select. If you wish to register a new provider, select Create New Provider. 

Create New Provider 

If you need to create a new provider, a form will be displayed for you to provide information 
about your provider. On this form provide 

• The title or name of your organization that will be listed as the provider 

• A brief description of the provider 

• Its mission 

You must then select which moderation group should review your provider registration. Then, 
select how long your provider should be active; you may select up to 12 months, after which you 
must either renew your registration, or it will be removed from public display. Next, you may 
optionally provide a URL for the provider site. Finally, you must supply your e-mail and phone 
number and, optionally, any comments to the moderator to help with the review of your 
registration. 

When you have completed this form, you may either Preview or Send Your Request to 
Moderator. 

When you send your registration, you will receive a confirmation of your submission. This will 
contain a ID of the Provider number. Note this number. You will receive notification of approval 
of the provider by e-mail. 

After you submit your provider registration, you must wait until it is approved before you can 
continue with an ad submission. 
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Select Type of Advertisement 

Once you have selected (or created a new) Provider, you will go to a screen to select the type of 
ad you wish to create. You may choose from 

• Create Data Advertisement 

• Create Web Service Advertisement 

• Create Non-Web Service Advertisement 

• Create Installable Service Advertisement 

If you choose Create Data Advertisement, you may choose either: Using Simple Fill-Out Form 
or Using Advanced FTP Template; the Simple Fill-Out Form is the default. 

Press Create Ad to advance you to the correct form. 

4.7.6	 Contribute an Advertisement - Create Data Advertisement Using Simple Fill 
Out Form 

If you select Create Data Advertisement Using the Simple Fill-Out Form, a new page will be 
displayed. This form requests all the basic information to submit a data ad. Here you must enter 
the product name (which will also be the title of the ad) and a product acronym that will be a 
short name for the product. The provider ID should be automatically filled out by the application 
by your choice on the Select Provider screen and normally would not need to be changed. The 
Version ID is your designation of the version, release, or revision of this product/service (1, 2, or 
3; or A, B, or C; or Alpha, Beta, etc). 

Then, you may optionally define a geographic coverage for the product by specifying bounding 
rectangle. This rectangle, bounded by a maximum north and south latitudes, and maximum east 
and west longitudes, defines the geographic limits of the product. The default selection covers 
the entire globe; however, you may reduce it as small as you need. Latitudes north of the Equator 
and Longitudes East of the Greenwich Meridian are designated as positive values. Latitudes 
south of the Equator and West of the Greenwich Meridian are negative values. 

Then, you may optionally define a temporal coverage for the product by specifying the 
beginning and ending dates defining the limits of the product. 

You may optionally define the instrument name and platform name associated with this product. 

The optional product URL is the internet address to access your product. The optional User's 
Guide URL is the internet address to access additional documentation about your product. 

The optional product revision date is your designation of when this product/service was last 
updated or revised. 

Next, you select how long your ad should be active; you may select up to 12 months, after which 
you must either renew your ad, or it will be removed from public display. 
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If your data are stored at one of the Distributed Active Archive Centers (DAACs) and other 
archive centers, specify that under Archive Center. 

Enter a detailed description of your data product under description, enough information to let 
users know what information you are providing and how they should use it. Make it as 
comprehensive as you feel necessary; however, try to keep to less than a screen of information to 
avoid overloading the user. You may also include HTML tags in your description. Please try to 
restrict entries to HTML 2.0 to allow everyone on the Web to see them. This allows you to 
include appropriate links to other locations, images, etc. 

Under related services, you may establish hyperlinks between ads. ESOD utilizes the Web's 
hyperlink facilities to clarify relationships between our entries. If you wish to link together a set 
of ads, list the IDs of other ads related to this entry. 

Then select which moderation group should review your ad and, optionally, any comments to the 
moderator to help with the review of your registration. 

When you have filled out this information, press Next. 

On the next screen, please fill out the contact person information. When you complete this, you 
may preview your ad or send it to the moderator. 

When you send your ad, you will receive a confirmation of your submission. This will contain a 
ID of the ad number. Note this number. You will receive notification of approval of the ad by e­
mail. 

4.7.7	 Contribute an Advertisement - Create Data Advertisement Using Advanced 
FTP Template 

If you select Create Data Advertisement Using the Advanced FTP Template, a new page will be 
displayed. This page contains a link to FTP template-specific help. To download the template, 
click Download and follow the associated instructions. 

Once you have completed the template, place it on a public (i.e., anonymous) FTP site from 
which ESOD can pull the file. After you have placed the file on public FTP site, insert the 
address of the this site in the first field of the on-line form on the same page from which you 
downloaded the template (Create Data Advertisement Using the Advanced FTP Template -> 
Download). 

Then select which moderation group should review your provider registration. Finally, supply 
your e-mail and phone number and, optionally, any comments to moderator to help with the 
review of your registration. 

When you send your ad, you will receive a confirmation of your submission. This will contain a 
ID of the ad number. Note this number. You will receive notification of approval of the ad by e­
mail. 
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4.7.8 Contribute an Advertisement - Create Various Service Advertisements 

If you selected any of the Create Web/Non-Web/Installable Service Advertisement options, a 
new page will be displayed. The forms for all three of these ads are very similar and will be 
described together. Special fields will be discussed separately. 

All the forms request that you enter a Title for the Advertisement. 

Enter a detailed description of your service under description, enough information to let users 
know what information, software, or service you are providing and how they may use it. Make it 
as comprehensive as you feel necessary; however, try to keep to less than a screen of information 
to avoid overloading the user. You may also include HTML tags in your description. Please try 
to restrict entries to HTML 2.0 to allow everyone on the Web to see them. This allows you to 
include appropriate links to other locations, images, etc. 

Next, select how long your ad should be active; you may select up to 12 months, after which you 
must either renew your ad or it will be removed from public display. 

The provider ID should be automatically filled out by the application by your choice on the 
Select Provider screen and normally would not need to be changed. 

Under Related Services, you may establish hyperlinks between ads. ESOD utilizes the Web's 
hyperlink facilities to clarify relationships between our entries. If you wish to link together a set 
of ads, list the IDs of other ads related to this entry. 

Then select which moderation group should review your provider registration. Finally, supply 
your e-mail and phone number and, optionally, any comments to the moderator to help with the 
review of your registration. 

In the Web Service Advertisement Form, you also enter a Service URL, which is the internet 
address to access your service. 

The Installable Service Advertisements are a special set of ads that advertise software that can be 
installed by the ESOD directly onto a user's workstation and specifically integrated into the 
EOSDIS X/Motif Desktop. If you wish to turn one of your applications into an installable 
application, you'll need to follow a set of special instructions. In the Installable Service 
Advertisement Form, you also enter a FTP URL. This is a public (i.e., anonymous) FTP site 
from which ESOD can pull the installable application after you have prepared it, tarred and 
compressed it into a file. You must also provide the size of the application after it is untarred. 

When you have completed this form, you may either Preview or Send Your Request to 
Moderator. 

When you send your ad, you will receive a confirmation of your submission. This will contain a 
ID of the ad number. Note this number. You will receive notification of approval of the ad by e­
mail. 
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4.7.9 Contribute an Advertisement - Update an Ad 

If you select Update Directory Entry, you access a form in which you can enter the ID of the ad 
you wish to update. If you don't remember the ID, you can select Browse Directory Entries to 
review an alphabetical listing. 

Once you enter the ad ID and submit it, the appropriate form based on the type of ad is 
displayed. These forms are similar to the Create Directory Entry Forms; however, the form fields 
are already filled with the existing information. You need only update the fields that you wish to 
change. 

Supply your e-mail and phone number and, optionally, any comments to moderator to help with 
the review of your update request. 

When you send your update, you will receive a confirmation of your submission. This will 
contain a ID of the Advertisement number. Note this number. You will receive notification of 
approval of the update by e-mail. 

4.7.10 Contribute an Advertisement - Delete an Ad 

If you select Delete Directory Entry, you access a form in which you can enter the ID of the 
advertisement you wish to delete. If you do not remember the ID, you can select Browse 
Directory Entries to review an alphabetical listing. 

Once you enter the ad ID and submit it, the ad is displayed. To delete the ad, supply your e-mail 
and phone number and, optionally, any comments to moderator to help with the review of your 
deletion request. 

When you send your deletion request, you will receive a confirmation of your submission. This 
will contain a ID of the Advertisement number. Note this number. You will receive notification 
of approval of the deletion request by e-mail. 

4.8 Document Acquisition Search Tool 

The Data Acquisition Request Tool (DART) provides motif-style graphical user interfaces 
(GUIs) to enable science users to submit Data Acquisition Requests (DARs), which are user 
scheduling data acquisition requests for the Advanced Spaceborne Thermal Emission and 
Reflection Radiometer (ASTER) instrument. These requests are submitted through ECS to the 
ASTER Ground Data System (GDS) in Japan. The ASTER GDS controls scheduling of the 
ASTER instrument and provides the collected data as level 1A and level 1B data to the EROS 
Data Center. 
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4.8.1 Main Window 

The Main Window of the Data Acquisition Request Tool (DART) uses a tabstack for primary 
navigation tool. 

The three tabs on the main window are: 

•	 Summary, which allows you to view a condensed presentation of xAR work, query 
parameters, and the returned results of submitted xAR request that are stored locally (on a 
hard drive or LAN). 

Figure 4-1. Summary Tab 
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•	 Create/Edit Request allows you to create a new xAR request or to edit the parameters of a 
previous xAR Request that is locally stored. 

Figure 4-2. Create/Edit Request Tab 
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•	 Modify Request allows you to search the ASTER database located in Japan for level 1A 
and level 1B data products stored there and fulfill the parameters of your request. 

Figure 4-3. Modify Request Tab 

When you launch the DAR tool from the desktop, the first tab, Summary, appears with the 
following four functional areas: 

1. Project Folders 

2. Spatial Requirements 

3. Temporal Requirements 

4. Parameters 

Project Folders are similar to a file manager. They display the xAR work that is stored locally (a 
hard drive or LAN), including xAR requests you may be still working on and the parameters of 
xARs that have been sent. 
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1. 	 Select an xAR Request and then the copy parameters button to populate the Spatial 
Requirements and Temporal Requirements and discrete fields with information relevant 
to the highlighted request. For instance, if you highlighted a folder in the Project Folders 
area containing all the results of a specific request, 

2. 	 The Spatial Requirements area would fill with a low-resolution image of the area of 
interest with outlines of all the xAR images that fulfill your request. 

3.	 The Temporal Requirements area would populate with the xAR request lifetime, repeat 
interval, and acquisition windows. When a single xAR is highlighted in the Projects 
folder area, a low-resolution image of the spatial data from that xAR appears in the 
Spatial Requirements areas and information about the specific xAR lifetime appears in 
the Temporal Requirements area. 

4.	 The Parameters would populate with a text list of all the saved parameters for any DAR 
request that is highlighted in the Project Folders area. 

If you wish to edit the contents of a xAR request stored locally (i.e., finish an incomplete xAR 
request that was saved or edit a previous xAR request for which the parameters had been saved), 
then you can select the desired item from the Project Folders list by clicking on it and then 
depressing the pushbutton below the Project Folders area that directs you to Copy parameters 
from highlighted item to: a button that says to Create/Edit Request Tab. 

The action will cause all parameters stored for the highlighted item to populate the appropriate 
fields in the Create/Edit Request tab where the you may inspect and/or edit them. 

4.8.2 Create/Edit Request 

From the Create/Edit Request tab, you may access all fields necessary or desirable for 
completing a DAR request or to edit existing xAR parameters. Navigate the following three 
screens to create or edit a xAR request. In addition, there are several additional functions that are 
available via popup windows. 

The first screen shows the contents of the Create/Edit Request tab, which contains many of the 
elements necessary to create or edit a DAR request. It also has a series of pushbuttons to invoke 
the spatial requirements and temporal requirements window as well as other advanced user 
options and special requests. Each DAR element is discussed in greater detail below. 

The DAR elements controlled directly on the Create/Edit Request tab include: 

• xAR Title 

• Investigation Class 

• Maximum Cloud Coverage 

• Lighting Requirements 

• xAR Status, Scientific Objective 

• Telescope Selection, and Gain Settings 
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The secondary windows and dialogs that can be spawned from the Create/Edit request tab 
include: 

• Spatial Requirements 

• Temporal Requirements 

• Advanced Viewing Geometry 

• Special Requests 

• Resource Estimate 

To invoke the secondary windows or popup dialogs for each of these functional groups, press the 
appropriate pushbutton on the right-hand side of the interface. A checkbox has been placed to the 
left of each pushbutton indicating that you've visited the location. This gives you a visual 
reference to show screens you've visited and saved entries or changes. So, when you visit a 
secondary window or popup screen, make entries or edits, and apply them, a checkmark appears 
in the checkbox next to the pushbutton that invoked the window in which the entries or changes 
were made. 

You must enter spatial and temporal requirements to complete a xAR request. In these fields, 
specify the area and time, respectively, for the ASTER image data you are requesting. Advanced 
Viewing Geometry includes the functionality to specify look and Sun angle if there are specific 
requirements for a particular DAR request. Special Requests include functionality to increase the 
priority of a request or expedite the delivery of scientific information. The Resource Estimate 
option executes an algorithm that estimates the number of scenes that will be returned from the 
xAR request. 

Finally, there is a button labeled Submit in the lower right-hand corner of the Create/Edit tab. 
When you have supplied all the xAR parameters to be input, press Submit to send the xAR 
request to ASTER Ground Data System (GDS). 

4.8.3 Data Elements of Create/Edit 

xAR Title 

xAR Title is a user-definable field containing a text-entry field allowing an entry of up to 32 
characters. With it you may supply a name or xAR Title to the DAR. The xAR Title is the name 
by which the DAR request will be stored, unless you otherwise specify. 

Investigation Class 

Under the heading Investigation Class is a combination box containing a list of geographical, 
climatological, and atmospheric sciences. Through the combination box, select the category of 
scientific research that most closely describes the research for which the DAR request is being 
placed. 

4-51 205-CD-004-001




Maximum Cloud Coverage 

Specify the maximum acceptable cloud coverage for scene images taken by the ASTER 
telescopes with the Maximum Cloud Coverage option button. The options button contains a list 
of all the allowed threshold choices for Maximum Cloud Coverage. Cloud Coverage is one of 
three parameters that can be modified after the DAR has been submitted. 

Lighting Requirements 

The Viewing Geometry area allows you to specify the Lighting Requirement, Sun Angle, View 
Swath, and Look Angle for the query. Lighting requirements are selected via a radio box and the 
default choice is Day Only. 

Scientific Objective 

A 256 character text field is provided so that researchers can provide a brief statement explaining 
the scientific objectives that a given DAR request is intended to support. 

Telescope Selection 

On the ASTER instrument platform, three telescopes are available for observing ASTER DAR 
data: 

1. Visible and Near-Infrared spectrum (VNIR) 

2. Short wave and Infrared spectrum (SWIR) 

3. Thermal Infrared spectrum (TIR) 

The DAR design allows you to specify which telescope(s) should be activated for the xAR 
request. To select the telescope for your requested DAR observation, go to the Create/Edit screen 
section labeled Telescope Selection. 

Of the three telescopes available, you may select one of five different telescope combinations. 
An option list is provided to pick from the five available combinations. The five combinations 
available to the user include 

•	 VNIR, SWIR, & TIR -- The full activation of all bands of the VNIR, SWIR, and TIR 
telescopes together. 

• VNIR Only -- The activation of all bands of the VNIR telescope only. 

• VNIR Stereo Only -- The activation of only the stereo settings of the VNIR telescope. 

•	 SWIR & TIR -- The activation of all bands of the SWIR and TIR telescopes. In this 
mode, no bands of the VNIR telescope are activated. 

•	 TIR Only -- The activation of the TIR telescope only. In this mode, no bands of the 
VNIR and SWIR telescopes are activated. 
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Gain Settings 

In addition to selecting the telescopes for the DAR observation, you may also request changes to 
the Gain Settings for the different band ranges available on the VNIR and SWIR telescope. 
VNIR has three bands to observe three different ranges of wavelength in the visible spectrum of 
light; SWIR has six bands to observe six different ranges within the short wave spectrum. 
Because of the nature of the observation made by TIR telescope (thermal data), it has no user­
defined gain settings. Immediately beneath the Telescope Selection area is another section 
labeled Gain Settings. In the Gain Settings area, you may request that the gain settings be 
changed for any or all bands of the VNIR or SWIR telescopes during the data take for their DAR 
request. For Bands 1, 2, and 3 (VNIR), you may set select from high, medium, and low gain 
settings. For Bands 4, 5, 6, 7, 8, and 9 (SWIR), you may set select from high, medium, low, and 
very low gain settings. By default, the gain settings for all bands for both telescopes are set to 
high. The gain setting for each band can be changed via on option button that is provided on the 
interface for each user-modifiable band. 

The ASTER science team anticipates that a majority of DAR requests will use the default gain 
setting (high) for all bands during most observations, making it unnecessary for the gain setting 
area be visible at all times, so, the radio box labeled, Show Gain Settings (found next to the 
Telescope Selection options button) allows you to control whether or not the Gain Setting 
controls are visible. The default setting for Show Gain Settings is No. In the No position, gain 
setting controls are not displayed. In the Yes position, the Gain Setting controls become visible 
immediately below the Telescope Selection area. 

Different telescope combinations affect the bands that are available for a particular observation. 
For instance, when you select VNIR Only, you need not set the gain settings for the SWIR 
telescope since you've specified that SWIR not be used. In instances where a particular telescope 
setting makes particular gain setting choices unnecessary, the unavailable gain setting button 
choices are disabled to ensure that you may change only the gain settings relevant to your 
telescope selection. The following list indicates all five possible telescope combinations that are 
available and the bands that are enabled as a result: When VNIR, SWIR, and TIR is selected, all 
bands are enabled. When VNIR Only is selected, Band 1, Band 2, & Band 3 are enabled. Bands 
4-9 are disabled. 

When VNIR Stereo Only is selected, only Band 3 is enabled. Controls for all other bands are 
disabled. When SWIR and TIR is selected, Band 4, Band 5, Band 6, Band 7, Band 8, and Band 
9 are enabled. Bands 1-3 are disabled. When TIR Only is selected, all bands are disabled. 

When you've completed the Create/Edit main screen, depresses Apply to accept the settings. 

4.8.4 Spatial Requirements 

The Spatial Requirements Screen allows you to define an Area of Interest (AOI) and specify 
coverage criteria such as sampling, cross-track fragmentation and area of interest duration for the 
request. The Spatial Requirements screen uses a tabstack to organize a variety of functions 
related to the map display in a way that is logical and that keeps them in close proximity to the 
map display. 
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The functional organization includes three tabs: 

• Pan and Zoom 

• Map Display Controls 

• Coverage Details 

Currently, the functionality of the map display had not been implemented. This design may 
undergo some modifications to accommodate the mapping tool as it is integrated to support the 
necessary mapping functionality. However, to the extent possible, this design will be preserved. 

Figure 4-4. Pan & Zoom 

The Spatial Requirements screen has several states on the map. These states allow you to 
perform various spatial selections while working with the map rather than the options of the Pan 
and Zoom tab. Select the state you would like to use by pressing the right mouse button to 
display the pulldown menu of state choices. Select Add Points, Pan, Zoom In, or Zoom Out from 
the pull down menu. 
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Each selection allows you to work directly with the map. You may also go to the Pan and Zoom 
tab and AOI and Map Display page to work with the options provided that perform the same 
functions as the states do when working with the map. 

Creating the Area of Interest Polygon 

Look immediately below the map display for a group of options labeled AOI Polygon Selection. 
This area contains the options that control text entry and modification of points in the AOI 
polygon. Most of these controls are initially disabled except for a pushbutton labeled Create 
AOI. When you depress the Create AOI pushbutton, the other AOI Polygon Selection options are 
enabled, and the map display area enters the polygon selection mode. In this state, an AOI 
polygon can be defined by one of two mechanisms: mouse operations on the GIS or text entry. 

After Create AOI has been depressed, you will be able to move that mouse over the map display 
and click the first mouse button to place a point of the AOI polygon, then continue to place 
points. After each point is placed, the polygon should be redrawn on the map. Also, the 
coordinates for each point placed by the mouse operation should appear in the extended list 
widget in the Area of Interest Polygon Selection section. 

The other method to enter points in the AOI polygon is to enter the latitude and longitude of the 
point (if the coordinates are known) in the text fields provided and then depress the button 
labeled Add Point. You will also be able to edit or delete a point via mouse operation or by 
keyboard. To edit a point via mouse, you will be able to click on the point where it is located on 
the map and drag it to a new location. Another option is to click on or tab to a point entry in the 
extended list to highlight it and depress the button labeled Modify Point. This action will result 
in the latitude and longitude text fields becoming repopulated with the coordinate data selected. 
At this point, you may modify the entry in the appropriate text fields and depress the accept 
changes or ignore changes button to either apply or reject the edit action. 
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Map Display Controls 

Figure 4-5. Map Display Controls Tab 

The second tab is Map Display Controls.This tab contains the controls responsible for map 
display, including the type of map, its resolution quality, and the projection of map overlays 
(such as rivers, borders, etc.). In addition, this includes views of the ASTER satellite's ground 
track and view swath for a user-specified period. 

You will use a combination box to select both the projection and the resolution of the DAR. The 
ground track and swath views begin and end date and times can be entered using the keyboard 
into a text field or with the up and down arrows to the right of the text fields (these must be in 
Coordinated Universal Time). The Swath View has two checkbox choices: Swath Angle Limits 
and Swath Ids. The Orbit Settings have the checkbox choices of Ascending or Descending. The 
final selections on the Map Overlay section are four checkboxes that a user may check to identify 
the requests to have rivers, lakes, international borders, and/or coastlines included in their DAR. 

4-56 205-CD-004-001




Coverage Details 

Figure 4-6. Coverage Details Tab 

The third is Coverage Details. Primarily, this tab possesses the controls responsible for selecting 
coverage method (normal or sampled), specifying whether full duration AOI is required (yes or 
no), and specifying cross-track fragmentation (yes or no). If you select coverage method, normal, 
the controls used to set the sampling parameters (minimum sampled length, maximum sampled 
length, number of samples, and coverage amount) should be disabled (greyed-out). Even though 
Coverage Amount is disabled, it should show a value of 100 percent. If you select sample for 
coverage method, this interface enables the controls used to set the sampling parameters 
(minimum sampled length, maximum sampled length, number of samples, and coverage 
amount), and the you may set these parameters. 

When you've selected the AOI and set all the desired parameters set, depress Apply to accept the 
settings. When you've pressed Apply, the check box beside the Spatial Requirements push button 
on the Create/Edit Request becomes checked-off and the user-specified spatial requirements are 
applied. 
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4.8.5 Temporal Requirements 

Use this window to specify the time (in days) that the Area of Interest (AOI) described in a DAR 
request are to be observed or request multiple observations at regularly scheduled intervals in a 
single DAR request. This window allows you to enter temporal information either textually or 
graphically. 

xAR Lifetime 

Figure 4-7. xAR Lifetime Window 

Use this screen to select the times at which observations for a specific xAR is to occur. For most 
observations, you must set the xAR Lifetime, which is the duration over which image data can be 
taken. So, you enter the date you wish observations to start and then, the date you wish them to 
end. 

In some instances, you may wish to request multiple observations of the same AOI at regularly 
scheduled intervals rather than get a steady stream of data during the entire xAR lifetime. If the 
you decide not to have a steady stream of data about a particular AOI but want image data from 
the same AOI at regularly timed intervals, choose the option to request multiple observations of 
the AOI. 

4-58 205-CD-004-001




Set two parameters to request multiple observations: Repeat Interval and Acquisition Window. 
They are interdependent, so both must be set to create multiple observations. 

•	 Repeat Interval, expressed in days and hours, is the amount of time separating the start of 
each desired observation. 

•	 Acquisition Window, also expressed in days and hours, refers to the duration of a data 
take within each Repeat Interval. 

The interface can be used to enter the parameters of xAR Lifetime, Repeat Interval, and 
Acquisition Window both graphically and textually. 

Time Increment, at the top of the screen, contains the text fields, arrow buttons, and option list 
for you to set the amount of time that is displayed in the timeline located directly beneath. The 
timeline, part of the Temporal display, is primary where you'll enter temporal information 
graphically. You will be able to interact with the Start Date and End Date pointers in the 
Temporal to set the xAR Lifetime. The Acquisition Window and Repeat Interval appear on 
separate lines, directly beneath the line for the xAR lifetime. You may interact on a timeline for 
both these parameters; the sequence doesn't matter. 

Entries for xAR Lifetime, Repeat Interval, and Acquisition Window made in the Temporal 
display are represented automatically in the appropriate text fields described following. 
Likewise, entries or edits made in the text fields for xAR Lifetime, Repeat Interval, and 
Acquisition Window will automatically update the Temporal display. All Repeat Interval and 
Acquisition Window information is displayed in two places: on the Temporal display and in an 
Extended List found to the right of the text controls labeled Start & End Dates for Acquisition 
Interval. 
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Specific Observation Time 

Figure 4-8. Specific Observation Time Window 

In a few instances, you may wish to select a Specific Observation Time. The Specific 
Observation Time option should not be used often, and its use is constrained by both time and 
space. If you select this option, you must provide a specific day and time as well as the duration 
of time that ASTER instruments are to be left on. Day and time must be specified with precision 
to the second, and duration is expressed in minutes and second. Due to limitations of satellite 
hardware, the duration of a specific observation cannot exceed 16 minutes per orbit. Also, if you 
enter a Specific Observation Time, any AOI data you enter is disregarded because the ASTER 
instruments can image only what is directly beneath the satellite at the specified time. 

To set a Specific Observation Time, you must select Specific Observation Time. This button is 
immediately below the Temporal display. Once the Specific Observation Time is selected, the 
Temporal display and Time Increment controls are disabled. Also, the text fields to set xAR 
Lifetime, Repeat Interval, and Acquisition Window are replaced with text fields to set the start 
time and duration of the Specific Observation Time. Specific Observation Time can be set only 
with these text controls. No graphical input is possible. 
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When all temporal requirements for the DAR Request have been set, depresses the Apply button 
to accept the settings. When Apply is pressed here, the check box beside the Temporal 
Requirements pushbutton of the Create/Edit Request tab becomes checked off. 

4.8.6 Advanced Viewing Geometry 

This option allows you to specify acceptable look angles, Sun angles, and/or view swaths for a 
given DAR request. To access any or all these options, press Advanced Viewing Geometry 
found on the Create/Edit Request Tab. That action invokes an Advanced Viewing Geometry 
popup dialog containing look angle, Sun angle, and view swaths options. 

Figure 4-9. Advanced Viewing Geometry Option 

Select Use Specified Look Angle and Use Specific View Swath by using the radio boxes 
provided. The default for both is No. If you select Yes to Use Specified Look Angle, then you 
must provide the Specified Look Angle. If you select Yes to Use Specific View Swath, then you 
must provide an integer value for Specific View Swath ID. The fields to enter Use Specified 
Look Angle and Use Specific View Swath are disabled until Yes for either option is selected. 

You may specify minimum and maximum degree angles for the Sun angle and look angle by 
either numeric text entry or by using the arrows buttons to the right of the text field to set 
numeric values within the field. 
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When you've set the desired cloud coverage, data transmission requirements, and viewing 
geometry, depress OK to accept the settings. When OK is pressed here, the check box beside 
Advanced Viewing Geometry of the Create/Edit Request tab gets checked off. 

4.8.7 Special Request 

Here you may specify special treatment of alternate arrangements for the delivery of ASTER 
data. Invoke a Special Requests by depressing Special Requests on the Create/Edit Request Tab. 

Figure 4-10. Special Request Dialog 

On this dialog, specify ground campaign and implementation urgency, request for expedited data 
or direct downlink, and provide additional comments on the nature of the science, or to justify 
special or preferential treatment of data. 
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One of your choices, Implementation Urgency, allows you to choose between Normal and 
Urgent priority. The default setting is Normal. If you select Urgent, the xAR Lifetime must be 
set to begin and end within 18 days following the request. Any request in which the xAR lifetime 
exceeds 18 days cannot be flagged Urgent. Conversely, if you flag a request Urgent prior to 
setting Temporal Requirements and attempt to enter a xAR lifetime end time that exceeds18 days 
(following the day the request is being submitted), your entry will not be allowed. 

4.8.8 Resource Estimation Algorithm Dialog 

The Resource Estimate option executes the following algorithm that estimates the number of 
scenes that will be returned from the xAR request. 

AOI x total # of repeats = #of scenes 3600 sq km (1 scene area) 

Figure 4-11. Resource Estimation Option 

This estimate is calculated when you depresses Resource Estimate, found on the Create/Edit 
Request tab of the DART main window. The result of the calculation is displayed in an 
information dialog; depress OK after viewing the result. 

4.8.9 xAR ID Dialog 

Submit is in the lower right-hand corner of the Create/Edit tab immediately below the checklist 
on the Create/Edit Request tab of the DART main window. When you've supplied all the xAR 
parameters to be input, depress Submit to send the xAR request to ASTER GDS. When Submit 
is pressed, a xAR ID should be returned to you from GDS several seconds later and displayed in 
a message dialog. 
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Figure 4-12. Submit 

If you haven't supplied all required elements of the DAR request before you depress Submit, a 
dialog appears advising you of the parameters that you still need to define. 

4.8.10 xAR ID Database Query 

4.8.11 Submission Information for Current xAR 

When you view the parameters for an existing or previously submitted xAR, you may wish to 
see the xAR ID, the original xAR submission date, or the last date modified. Also, if DART 
capabilities are extended to instruments aside from ASTER at some point in the future, it may be 
useful to see what instrument(s) were specified to execute the xAR request. 
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Figure 4-13. View 

Under the View menu, depressing Submission Information for Current xAR opens a dialog box 
that allows you to see the xAR ID, Requester ID, Sensor, Original Submission date, and last 
update of a DAR request that has been previously submitted to ASTER GDS. 
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